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Product features

Standard configuration features
Features may vary depending on the model. For a complete listing of the hardware and software
installed in the computer, run the diagnostic utility (included on some computer models only).
NOTE: All three computer models can be used in a tower orientation or a desktop orientation.

Tower (TWR)

Standard configuration features

1

Small Form Factor (SFF)

Ultra-slim Desktop (USDT)

2
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Tower (TWR) front panel components
Drive configuration may vary by model. Some models have a bezel blank covering one or more drive
bays.

1

5.25-inch Half-Height Drive Bay (behind bezel)

6

Hard Drive Activity Light

2

USB 2.0 Ports (black)

7

Slim Optical Drive (optional)

3

USB 3.0 Ports (blue)

8

3.5-inch Media Card Reader (optional)

4

Headphone Connector

9

Microphone/Headphone Connector

5

Dual-State Power Button

NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if
you want to use the connector for a microphone Line-In device or a headphone. You can reconfigure the connector
at any time by double-clicking the Audio Manager icon in the Windows taskbar.
NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code. Refer to Interpreting POST diagnostic front panel LEDs and
audible codes on page 245 to interpret the code.

Tower (TWR) front panel components
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Small Form Factor (SFF) front panel components
Drive configuration may vary by model. Some models have a bezel blank covering one or more drive
bays.

1

Slim Optical Drive (optional)

5

Headphone Connector

2

USB 2.0 Ports (black)

6

Dual-State Power Button

3

USB 3.0 Ports (blue)

7

Hard Drive Activity Light

4

Microphone/Headphone Connector

8

3.5-inch Media Card Reader (optional)

NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if
you want to use the connector for a microphone Line-In device or a headphone. You can reconfigure the connector
at any time by double-clicking the Audio Manager icon in the Windows taskbar.
NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code.Refer to Interpreting POST diagnostic front panel LEDs and
audible codes on page 245 to interpret the code.
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Ultra-slim Desktop (USDT) front panel components
Drive configuration may vary by model. Some models have a bezel blank covering the optical drive
bay.

1

Slim Optical Drive (optional)

5

Headphone Connector

2

USB 2.0 Ports (black)

6

Hard Drive Activity Light

3

USB 3.0 Ports (blue)

7

Dual-State Power Button

4

Microphone/Headphone Connector

8

SD Media Card Reader (optional)

NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if
you want to use the connector for a microphone Line-In device or a headphone. You can reconfigure the connector
at any time by double-clicking the Audio Manager icon in the Windows taskbar.
NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code.Refer to Interpreting POST diagnostic front panel LEDs and
audible codes on page 245 to interpret the code.

Ultra-slim Desktop (USDT) front panel components
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Tower (TWR) rear panel components

1

Power Cord Connector

7

Line-Out Connector for powered audio
devices (green)

2

PS/2 Keyboard Connector (purple)

8

PS/2 Mouse Connector (green)

3

USB 2.0 Ports (black)

9

RJ-45 Network Connector

4

DisplayPort Monitor Connectors

10

Serial Connector

5

VGA Monitor Connector

11

Line-In Audio Connector (blue)

6

USB 3.0 Ports (blue)

NOTE:

An optional second serial port and an optional parallel port are available from HP.

When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if you want to use
the connector for a line-in device or a microphone. You can reconfigure the connector at any time by double-clicking
the Audio Manager icon in the Windows taskbar.
When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and
the integrated graphics on the system board may be used at the same time. However, for such a configuration, only
the display connected to the discrete graphics card will display POST messages.
The system board graphics can be disabled by changing settings in Computer Setup.
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Small Form Factor (SFF) rear panel components

1

PS/2 Mouse Connector (green)

7

PS/2 Keyboard Connector (purple)

2

RJ-45 Network Connector

8

DisplayPort Monitor Connectors

3

Serial Connector

9

VGA Monitor Connector

4

USB 2.0 Ports (black)

10

USB 3.0 Ports (blue)

5

Line-In Audio Connector (blue)

11

Line-Out Connector for powered audio
devices (green)

6

Power Cord Connector

NOTE:

An optional second serial port and an optional parallel port are available from HP.

When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if you want to use
the connector for a line-in device or a microphone. You can reconfigure the connector at any time by double-clicking
the Audio Manager icon in the Windows taskbar.
When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and
the integrated graphics on the system board may be used at the same time. However, for such a configuration, only
the display connected to the discrete graphics card will display POST messages.
The system board graphics can be disabled by changing settings in Computer Setup.

Small Form Factor (SFF) rear panel components
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Ultra-slim Desktop (USDT) rear panel components

1

Line-Out Connector for powered audio devices
(green)

6

VGA Monitor Connector

2

USB 2.0 Ports (black)

7

Power Cord Connector

3

USB 3.0 Ports (blue)

8

Line-In Audio Connector (blue)

4

DisplayPort Monitor Connectors

9

RJ-45 Network Connector

5

PS/2 Keyboard Connector (purple)

10

PS/2 Mouse Connector (green)

NOTE: When a device is plugged into the blue Line-In Audio Connector, a dialog box will pop up asking if you
want to use the connector for a line-in device or a microphone. You can reconfigure the connector at any time by
double-clicking the Audio Manager icon in the Windows taskbar.
If an MXM graphics card is installed, all of the video connectors may be used at the same time. However, for such a
configuration, only the display connected to the upper DisplayPort will display POST messages.
The system board graphics can be disabled by changing settings in Computer Setup.

Serial number location
Each computer has a unique serial number and a product ID number that are located on the exterior of
the computer. Keep these numbers available for use when contacting customer service for assistance.
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Tower (TWR)

Small Form Factor (SFF)

Serial number location

9

Ultra-slim Desktop (USDT)
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Activating and Customizing the
Software

NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in
Windows 7
If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.
CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.
NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows operating system
The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.
We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.
CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.
NOTE: If the computer shipped with more than one operating system language on the hard drive, the
activation process could take up to 60 minutes.

Activating and customizing the software in Windows 7
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Downloading Windows 7 updates
Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.
1.

To set up your Internet connection, click Start > Internet Explorer and follow the instructions
on the screen.

2.

After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3.

Run Windows Update monthly thereafter.

Installing or upgrading device drivers
When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.
In Windows 7, if prompted for the i386 directory, replace the path specification with C:\i386, or use
the Browse button in the dialog box to locate the i386 folder. This action points the operating system
to the appropriate drivers.
Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display
If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.
For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.
Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in
Windows 8
Additional information is available in online help after you activate the operating system.
NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows Operating System
The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.
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We recommend that you register your computer with HP during operating system set up so you can
receive important software updates, facilitate support questions, and sign up for special offers. You can
also register your computer with HP using the Register with HP app on the Start screen.
CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

Downloading Windows 8 updates
Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.
Run Windows Update as soon as possible after you set up your computer.
1.

Point to the upper-right or lower-right corner of the Start screen to display the charms.

2.

Click Settings > Change PC Settings > Windows Update.

3.

Run Windows Update monthly thereafter.

Customizing the monitor display
You can customize display settings for Windows 8 separately for the Start screen and the Desktop.
To customize the Start screen:
1.

Point to the upper-right or lower-right corner of the Start screen to display the charms.

2.

Click Settings > Change PC Settings.

3.

Click Personalize to change the display settings.

To customize the Desktop:
1.

Click the Desktop app on the Start screen.

2.

Right-click on the desktop, and then click Personalize to change display settings.

Activating and customizing the software in Windows 8
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3

Illustrated parts catalog

This chapter provides spare part information for all chassis.

Tower (TWR) chassis spare parts
Computer major components
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Item

Description

(1)

Front bezel

Spare part number

For use in all countries and regions except China

732751-001

For use in China

732752-001

(2)

Access panel

732748-001

(3)

Power supply
320W, 92% efficient

702452-001

320W, 90% efficient

702453-001

320W, standard

702454-001

320W, HV, standard

707906-001

(4)

HP PCI expansion slot daughter card

696971-001

(5)

System board (includes replacement thermal material)
For use in models without Windows 8

696969-001

For use in models with Windows 8 Standard

696969-501

For use in models with Windows 8 Professional

696969-601

For use in models with NetClone

727720-001

Memory modules (PC3-12800)
8-GB

689375-001

4-GB

671613-001

2-GB

671612-001

Processors (include replacement thermal material)
Intel Core i7 4770 (3.4-GHz, 8-MB L3 cache)

727373-001

Intel Core i5 4670 (3.4-GHz, 6-MB L3 cache)

727381-001

Intel Core i5 4570 (3.2-GHz, 6-MB L3 cache)

727380-001

Tower (TWR) chassis spare parts
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Cables
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Item

Description

Spare part number

(1)

Front I/O assembly

732750-001

(2)

Power switch/LED assembly

732749-001

(3)

Drive power cable

732754-001

Hard drive SATA cable, 14 inch, 1 straight end, 1 angled end

732753-001

Hard drive SATA cable, 17.7 inch, 2 straight ends

639959-001

SATA cable, 18 inch, 1 straight end, 1 angled end

646830-001

DMS-59 to dual VGA cable

463023-001

Adapter, DisplayPort to VGA

632484-001

Adapter, DisplayPort to DVI

662723-001

Adapter, DisplayPort to HDMI

617450-001

DisplayPort cable

487562-001

Chapter 3 Illustrated parts catalog

Miscellaneous parts

Item

Description

Spare part number

(1)

Fan sink (includes replacement thermal material)

727142-001

(2)

Solenoid lock

641498-001

(3)

Speaker (40 x 70 mm)

645330-001

(4)

Hood sensor

638816-001

(5)

Fan

727135-001

Optical drive 5.25-inch bezel blank

732770-001

Printer port, PCI card

638817-001

HP Ultraslim Keyed Cable Lock

703372-001

Hard drive conversion bracket

397117-001

Serial port, PCI card

638815-001

USB powered speakers

636917-001

Mouse
PS2, optical

674315-001

USB, HP Elite

674318-001

Washable

724795-001

Wireless, HP Elite

674317-001

USB, optical

674316-001

Foot kit

460890-001

Tower (TWR) chassis spare parts
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Item

Description

Spare part number

Keyboard
PS/2

724718-xx1

USB

724720-xx1

USB, wireless

724722-xx1

Smart card

701427-xx1

Wireless keyboard, mouse, and dongle

730323-xx1

Mass storage devices
Description

Spare part number

Hard drive
2 TB, 7200 rpm

616608-001

1 TB, hybrid SSD, 2.5-inch hard drive

724937-001

1 TB, 10000 rpm

719106-001

1 TB, 7200 rpm

613202-001

750 GB, 7200 rpm, hybrid SSD, 2.5-inch hard drive

719105-001

500 GB, 10000 rpm

683923-001

500 GB, 7200 rpm, self-encrypting (SED)

696442-001

500 GB, hybrid SSD, 2.5-inch hard drive

724938-001

256 GB Solid-state Drive (SSD), self-encrypting (SED)

680020-001

128 GB Solid-state Drive (SSD)

665961-001

32 GB mSATA drive, 2.5-inch

686616-001

32 GB mSATA drive

719566-001

Optical drive

18

Blu-ray BD-RW SuperMulti XL Drive

719157-001

DVD±RW drive

657958-001

DVD-ROM drive

608394-001
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Misc boards
Description

Spare part number

nVidia Quadro NVS310 PCIe x16 graphics card, 512 MB

707252-001

nVidia Quadro NVS315 PCIe x16 graphics card, 1 GB

720837-001

AMD Radeon HD8490 PCIe x16 graphics card, 1 GB

717219-001

AMD Radeon HD8470 PCIe x16 graphics card, 2 GB DDR3

729085-001

AMD Radeon HD 8350 1GB PCIe x16 DH GFX

717220-001

AMD Radeon HD8350 PCIe x16 graphics card, 1 GB DDR3

729084-001

GeForce GT630 PCIe x16 graphics card, 2 GB

702084-001

Intel PRO/1000 single port GbE NIC, includes bracket

728562-001

HP WLAN 802.11 a/b/g/n 2x2 PCIe module

695915-001

Sequential part number listing
Spare part
number

Description

397117-001

Hard drive conversion bracket

460890-001

Foot kit

463023-001

DMS-59 to dual VGA cable

487562-001

DisplayPort cable

608394-001

DVD-ROM drive

613202-001

1 TB, 7200 rpm hard drive

616608-001

2 TB, 7200 rpm SATA hard drive

617450-001

Adapter, DisplayPort to HDMI

662723-001

Adapter, DisplayPort to DVI

632484-001

Adapter, DisplayPort to VGA

636917-001

USB powered speakers

638815-001

Serial port PCI card

638816-001

Hood sensor

638817-001

Printer port, PCI card

639959-001

Hard drive SATA cable, 17.7 inch, 2 straight ends

641498-001

Solenoid lock

643907-001

Fan sink (includes replacement thermal material)

Tower (TWR) chassis spare parts
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Spare part
number

Description

643908-001

Chassis fan

645330-001

Speaker (40 x 70 mm)

646831-001

Hard drive power cable

646832-001

SATA optical drive power cable

657958-001

DVD±RW drive

665961-001

128-GB Solid-state drive

671612-001

Memory module, 2-GB, PC3 12800

671613-001

Memory module, 4-GB, PC3-12800

674315-001

Mouse, PS2, optical

674316-001

Mouse, USB, optical

674317-001

Mouse, wireless

674318-001

Mouse, USB

680020-001

256 GB Solid-state drive, self-encrypting (SED)

683923-001

500 GB, 10000 rpm SATA hard drive

686616-001

32 GB mSATA drive, 2.5-inch

689375-001

Memory module, 8-GB, PC3-12800

695915-001

HP WLAN 802.11 a/b/g/n 2x2 PCIe NIC

696442-001

500 GB, 7200 rpm hard drive, self-encrypting (SED)

696969-001

System board for use in models without Windows 8 (includes replacement thermal material)

696969-501

System board for use in models with Windows 8 Standard (includes replacement thermal material)

696969-601

System board for use in models with Windows 8 Professional (includes replacement thermal material)

696971-001

HP PCI expansion slot daughter card

701427-xx1

Keyboard, smart card, for use in models with Windows 8

702084-001

GeForce GT630 PCIe x16 graphics card, 2 GB

702452-001

320W, 92% efficient

702453-001

320W, 90% efficient

702454-001

320W, standard

703372-001

HP Ultraslim Keyed Cable Lock

707252-001

nVidia Quadro NVS310 PCIe x16 graphics card, 512 MB

707906-001

320W, HV, standard

717219-001

AMD Radeon HD8490 PCIe x16 graphics card, 1 GB

717220-001

AMD Radeon HD 8350 1GB PCIe x16 DH GFX
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Spare part
number

Description

719105-001

750 GB, 7200 rpm, 2.5-inch hard drive, hybrid SSD

719106-001

1 TB, 10000 rpm hard drive

719157-001

Blu-ray BD-RW SuperMulti XL Drive

719566-001

32 GB mSATA drive

720837-001

nVidia Quadro NVS315 PCIe x16 graphics card, 1 GB

724718-xx1

Keyboard, PS/2, for use in models with Windows 8

724720-xx1

Keyboard, USB, black, for use in models with Windows 8

724722-xx1

Keyboard, wireless, for use in models with Windows 8

724795-001

Mouse, washable

724937-001

1 TB hard drive, hybrid SSD, 2.5-inch hard drive

724938-001

500 GB hard drive, hybrid SSD, 2.5-inch hard drive

727135-001

Rear chassis fan

727142-001

Fan sink (includes replacement thermal material)

727373-001

Intel Core i7 4770 processor (3.4-GHz, 8-MB L3 cache) (includes thermal material)

727380-001

Intel Core i5 4570 processor (3.2-GHz, 6-MB L3 cache) (includes thermal material)

727381-001

Intel Core i5 4670 processor (3.4-GHz, 6-MB L3 cache) (includes thermal material)

727720-001

System board for use in NetClone models

728562-001

Intel PRO/1000 single port GbE NIC, includes bracket

729084-001

AMD Radeon HD8350 PCIe x16 graphics card, 1 GB DDR3

729085-001

AMD Radeon HD8470 PCIe x16 graphics card, 2 GB DDR3

730323-xx1

Wireless keyboard, mouse, and dongle

732748-001

Access panel

732749-001

Power switch/LED with holder

732750-001

Front I/O assembly

732751-001

Front bezel for use in all countries and regions except for China

732752-001

Front bezel for use in China

732753-001

Hard drive SATA cable, 14 inch, 1 straight end, 1 angled end

732754-001

Drive power cable

732770-001

Optical drive 5.25-inch bezel blank

Tower (TWR) chassis spare parts
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Small Form Factor (SFF) chassis spare parts
Computer major components

Item

Description

Spare part number

(1)

Front bezel

732757-001

(2)

Access panel

732760-001

(3)

Power supply

(4)

240W, 92% efficient

702455-001

240W, 90% efficient

702456-001

240W, standard

702457-001

System board (includes replacement thermal material)
For use in models without Windows 8

717522-001

For use in models with Windows 8 Standard

717522-501

For use in models with Windows 8 Professional

717522-601

For use in models with NetClone

727722-001

Memory modules (PC3-12800)
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Item

Description

Spare part number

8-GB

689375-001

4-GB

671613-001

2-GB

671612-001

Processors (include replacement thermal material)
Intel Core i7 4770 (3.4-GHz, 8-MB L3 cache)

727373-001

Intel Core i5 4670 (3.4-GHz, 6-MB L3 cache)

727381-001

Intel Core i5 4570 (3.2-GHz, 6-MB L3 cache)

727380-001

Item

Description

Spare part number

(1)

Front I/O assembly

732755-001

(2)

Power switch assembly

732756-001

(3)

SATA drive power cable

732759-001

Hard drive SATA cable, 14 inch, 1 straight end, 1 angled end

732753-001

Optical drive SATA cable, 19.5 inch, 2 straight ends

638813-001

SATA cable, 25.2 inch, 1 straight end, 1 angled end

638814-001

DMS-59 to dual VGA cable

463023-001

Adapter, DisplayPort to VGA

632484-001

Adapter, DisplayPort to DVI

662723-001

Adapter, DisplayPort to HDMI

617450-001

DisplayPort cable

487562-001

Cables

Small Form Factor (SFF) chassis spare parts
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Miscellaneous parts

Item

Description

Spare part number

(1)

Fan sink (includes replacement thermal material)

727150-001

(2)

Fan duct

727145-001

(3)

Speaker

727149-001

(4)

Hood sensor

638816-001

Optical drive bezel blank

732769-001

Solenoid lock

732772-001

Printer port, PCI card

638817-001

HP Ultraslim Keyed Cable Lock

703372-001

Rubber foot kit (includes four rubber feet)

583654-001

Chassis stand

688952-001

Serial port, PCI card

638815-001

Hard drive conversion bracket

397117-001

USB powered speakers

636917-001

Mouse
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PS2, optical

674315-001

USB, HP Elite

674318-001

Washable

724795-001

Wireless, HP Elite

674317-001

USB, optical

674316-001

Rubber foot kit (includes four rubber feet)

583654-001
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Item

Description

Spare part number

Keyboard
PS/2

724718-xx1

USB

724720-xx1

USB, wireless

724722-xx1

Smart card

701427-xx1

Wireless keyboard, mouse, and dongle

730323-xx1

Mass storage devices
Description

Spare part number

Hard drive
2 TB, 7200 rpm

616608-001

1 TB hard drive, hybrid SSD, 2.5-inch hard drive

724937-001

1 TB, 10000 rpm

719106-001

1 TB, 7200 rpm

613202-001

750 GB, 7200 rpm, hybrid SSD, 2.5-inch hard drive

719105-001

500 GB, 10000 rpm

683923-001

500 GB, 7200 rpm, self-encrypting (SED)

696442-001

500 GB hard drive, hybrid SSD, 2.5-inch hard drive

724938-001

256-GB Solid-state Drive (SSD), self-encrypting (SED)

680020-001

128-GB Solid-state Drive (SSD)

665961-001

32 GB mSATA drive

719566-001

32 GB mSATA drive, 2.5-inch

686616-001

Optical drive
Blu-ray BD-RW SuperMulti XL Drive

719157-001

DVD±RW drive

657958-001

DVD-ROM drive

608394-001

NOTE: 2.5-inch solid-state drives require an adapter for installation.

Small Form Factor (SFF) chassis spare parts
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Misc boards
Description

Spare part number

nVidia Quadro NVS310 PCIe x16 graphics card, 512 MB

707252-001

nVidia Quadro NVS315 PCIe x16 graphics card, 1 GB

720837-001

AMD Radeon HD8490 PCIe x16 graphics card, 1 GB

717219-001

AMD Radeon HD8450 PCIe x16 graphics card, 1 GB

717220-001

GeForce GT630 PCIe x16 graphics card, 2 GB

702084-001

Intel PRO/1000 single port GbE NIC, includes bracket

728562-001

HP WLAN 802.11 a/b/g/n 2x2 PCIe module

695915-001

Sequential part number listing
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Spare part
number

Description

397117-001

Hard drive conversion bracket

463023-001

DMS-59 to dual VGA cable

487562-001

DisplayPort cable

583654-001

Rubber foot kit (includes four rubber feet)

608394-001

DVD-ROM drive

613202-001

1 TB, 7200 rpm hard drive

616608-001

2 TB, 7200 rpm SATA hard drive

617450-001

Adapter, DisplayPort to HDMI

632484-001

Adapter, DisplayPort to VGA

636917-001

USB powered speakers

638813-001

Optical drive SATA cable, 19.5 inch, 2 straight ends

638814-001

SATA cable, 25.2 inch, 1 straight end, 1 angled end

638815-001

Serial port PCI card

638816-001

Hood sensor

638817-001

Printer port, PCI card

657958-001

DVD±RW drive

662723-001

Adapter, DisplayPort to DVI

665961-001

128-GB Solid-state drive

671612-001

Memory module, 2-GB, PC3 12800

Chapter 3 Illustrated parts catalog

Spare part
number

Description

671613-001

Memory module, 4-GB, PC3-12800

674317-001

Mouse, wireless, HP Elite

674318-001

Mouse, USB, HP Elite

674315-001

Mouse, PS2, optical

674316-001

Mouse, USB, optical

680020-001

256-GB Solid-state drive, self-encrypting (SED)

683923-001

500 GB, 10000 rpm SATA hard drive

686616-001

32 GB mSATA drive, 2.5-inch

688952-001

Chassis stand

689375-001

Memory module, 8-GB, PC3-12800

695915-001

HP WLAN 802.11 a/b/g/n 2x2 PCIe NIC

696442-001

500 GB, 7200 rpm hard drive, self-encrypting (SED)

701427-xx1

Keyboard, smart card, for use in models with Windows 8

702455-001

320W, 92% efficient

702456-001

320W, 90% efficient

702457-001

320W, standard

703372-001

HP Ultraslim Keyed Cable Lock

707252-001

nVidia Quadro NVS310 PCIe x16 graphics card, 512 MB

717219-001

AMD Radeon HD8490 PCIe x16 graphics card, 1 GB

717220-001

AMD Radeon HD8450 PCIe x16 graphics card, 1 GB

717522-001

System board for use in models without Windows 8 (includes replacement thermal material)

717522-501

System board for use in models with Windows 8 Standard (includes replacement thermal material)

717522-601

System board for use in models with Windows 8 Professional (includes replacement thermal material)

719105-001

750 GB, 7200 rpm, 2.5-inch, hard drive, hybrid SSD

719106-001

1 TB, 10000 rpm hard drive

719157-001

Blu-ray BD-RW SuperMulti XL Drive

719566-001

32 GB mSATA drive

720837-001

nVidia Quadro NVS315 PCIe x16 graphics card, 1 GB

724718-xx1

Keyboard, PS/2, for use in models with Windows 8

724720-xx1

Keyboard, USB, black, for use in models with Windows 8

724722-xx1

Keyboard, wireless, for use in models with Windows 8

724795-001

Mouse, washable

Small Form Factor (SFF) chassis spare parts
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28

Spare part
number

Description

724937-001

1 TB hard drive, hybrid SSD, 2.5-inch hard drive

724938-001

500 GB hard drive, hybrid SSD, 2.5-inch hard drive

727145-001

Fan duct

727149-001

Speaker

727150-001

Fan sink

727373-001

Intel Core i7 4770 processor (3.4-GHz, 8-MB L3 cache) (includes thermal material)

727380-001

Intel Core i5 4570 processor (3.2-GHz, 6-MB L3 cache) (includes thermal material)

727381-001

Intel Core i5 4670 processor (3.4-GHz, 6-MB L3 cache) (includes thermal material)

727722-001

System board for use in NetClone models (includes replacement thermal material)

728562-001

Intel PRO/1000 single port GbE NIC, includes bracket

732753-001

Hard drive SATA cable, 14 inch, 1 straight end, 1 angled end

732759-001

SATA drive power cable

732755-001

Front I/O cable assembly

732756-001

Power switch assembly

732757-001

Front bezel

732760-001

Access panel

732769-001

Optical drive bezel blank

732772-001

Solenoid lock
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Ultra-Slim Desktop (USDT) chassis spare parts
Computer major components

Item

Description

Spare part number

(1)

Access panel

732763-001

(2)

Front bezel

732764-001

(3)

Stand

612496-001

(4)

System board (includes replacement thermal material)
For use in models without Windows 8

696970-001

For use in models with Windows 8 Standard

696970-501

For use in models with Windows 8 Professional

696970-601

For use in models with NetClone

727721-001

AC adapter
180W, standard

613766-001

135W, standard

648964-001

Memory modules (PC3-12800)
8-GB

689374-001

4-GB

689373-001

Ultra-Slim Desktop (USDT) chassis spare parts
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Item

Description

Spare part number

2-GB

689372-001

Processors (include replacement thermal material)
Intel Core i7 4770s (3.1-GHz, 8-MB L3 cache)

732507-001

Intel Core i5 4670s (3.1-GHz, 6-MB L3 cache)

732506-001

Intel Core i5 4570s (2.9-GHz, 6-MB L3 cache)

732505-001

Item

Description

Spare part number

(1)

Optical drive cable/connector

605163-001

Adapter, DisplayPort to VGA

632484-001

Adapter, DisplayPort to DVI

662723-001

Adapter, DisplayPort to HDMI

617450-001

DisplayPort cable

487562-001

Cables
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Miscellaneous parts

Item

Description

Spare part number

(1)

Heat sink for use with the processor (includes replacement thermal material)

587456-001

Heat sink for use with the discrete graphics card (includes replacement thermal
material; not illustrated)

689369-001

(2)

Power switch assembly

732767-001

(3)

Speaker

689384-001

(4)

Rear port cover

588981-001

(5)

Fan, rear

732766-001

(6)

Front I/O panel

732762-001

(7)

Chassis fan, front

732765-001

Optical drive bezel blank

732771-001

Card reader, UHS-I

716390-001

Card reader, UHS-II

736299-001

Solenoid lock

732772-001

HP Ultraslim Keyed Cable Lock

703372-001

Optical disc drive mounting cage

732761-001

Ultra-Slim Desktop (USDT) chassis spare parts
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Item

Description

Spare part number

USB powered speakers

636917-001

Mouse
PS2, optical

674315-001

USB, HP Elite

674318-001

Washable

724795-001

Wireless, HP Elite

674317-001

USB, optical

674316-001

Keyboard
PS/2

724718-xx1

USB, basic

724720-xx1

USB, wireless

724722-xx1

Smart card

701427-xx1

Wireless keyboard, dongle, and mouse

730323-xx1

Mass storage devices
Description

Spare part number

Hard drive
750 GB, 7200 rpm, hybrid SSD

719105-001

500 GB, 7200 rpm, self-encrypting (SED)

696442-001

500 GB, 7200 rpm

686217-001

320 GB, 7200 rpm

639135-001

500 GB hard drive, hybrid SSD

724938-001

256-GB Solid-state Drive (SSD), self-encrypting (SED)

680020-001

128-GB Solid-state Drive (SSD)

665961-001

32-GB Solid-state Drive (SSD), 2.5-inch

686616-001

32-GB mSATA drive

719566-001

Optical drive
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DVD-ROM drive

608394-001

DVD±RW drive

657958-001

Blu-ray BD-RW SuperMulti XL Drive

719157-001
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Misc boards
Description

Spare part number

AMD Radeon HD 7650A 2GB MXM Graphics

708866-001

HP WLAN 802.11 a/b/g/n 2x2 PCIe NIC

695915-001

Sequential part number listing
Spare part
number

Description

487562-001

DisplayPort cable

587456-001

Heat sink for use with the processor (includes thermal material)

605163-001

Optical drive cable/connector

608394-001

DVD-ROM drive

612496-001

Stand

613766-001

180-W power adapter, standard

617450-001

Adapter, DisplayPort to HDMI

632484-001

Adapter, DisplayPort to VGA

636917-001

USB powered speakers

638816-001

Hood sensor

639135-001

320 GB, 7200 rpm hard drive

648964-001

AC adapter, 135W, standard

657958-001

DVD±RW drive

662723-001

Adapter, DisplayPort to DVI

665961-001

128-GB Solid-state drive

674315-001

Mouse, PS2, optical

674316-001

Mouse, USB, optical

674317-001

Mouse, wireless, HP Elite

674318-001

Mouse, USB, HP Elite

680020-001

256-GB Solid-state drive, self-encrypting (SED)

686217-001

500 GB, 7200 rpm hard drive

686616-001

32-GB Solid-state drive, 2.5-inch

689369-001

Heat sink for use on models with discrete graphics cards (includes thermal material)

689372-001

Memory module, 2-GB, PC3-12800

Ultra-Slim Desktop (USDT) chassis spare parts
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34

Spare part
number

Description

689373-001

Memory module, 4-GB, PC3-12800

689374-001

Memory module, 8-GB, PC3-12800

689384-001

Speaker

695915-001

HP WLAN 802.11 a/b/g/n 2x2 PCIe NIC

696442-001

500 GB, 7200 rpm, self-encrypting (SED) hard drive

696970-001

System board (includes replacement thermal material)

701427-xx1

Keyboard, smart card, for use in models with Windows 8

703372-001

HP Ultraslim Keyed Cable Lock

708866-001

AMD Radeon HD 7650A 2GB MXM Graphics

716390-001

Card reader, UHS-I

719105-001

750 GB, 7200 rpm hard drive, hybrid SSD

719157-001

Blu-ray BD-RW SuperMulti XL Drive

719566-001

32-GB mSATA drive

724718-xx1

Keyboard, PS/2, for use in models with Windows 8

724720-xx1

Keyboard, USB, black, for use in models with Windows 8

724722-xx1

Keyboard, wireless, for use in models with Windows 8

724795-001

Mouse, washable

724938-001

500 GB hard drive, hybrid SSD

727721-001

System board for use in NetClone models

732505-001

Intel Core i5 4570s processor (2.9-GHz, 6-MB L3 cache) (includes thermal material)

732506-001

Intel Core i5 4670s processor (3.1-GHz, 6-MB L3 cache) (includes thermal material)

732507-001

Intel Core i7 4770s processor (3.1-GHz, 8-MB L3 cache) (includes thermal material)

732761-001

Optical disc drive mounting cage

732762-001

Front I/O assembly

732763-001

Access panel

732764-001

Front bezel

732765-001

Front fan

732766-001

Chassis fan, rear

732767-001

Power switch assembly

732771-001

Optical drive bezel blank

732772-001

Solenoid lock

736299-001

Card reader, UHS-II
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Routine care, SATA drive
guidelines, and disassembly
preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.
Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Electrostatic discharge information
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Generating static
The following table shows that:
●

Different activities generate different amounts of static electricity.

●

Static electricity increases as humidity decreases.
Relative Humidity

Event

55%

40%

10%

Walking across carpet

7,500 V

15,000 V

35,000 V

Walking across vinyl floor

3,000 V

5,000 V

12,000 V

Motions of bench worker

400 V

800 V

6,000 V

Removing DIPs from plastic tube

400 V

700 V

2,000 V

Removing DIPs from vinyl tray

2,000 V

4,000 V

11,500 V

Removing DIPs from Styrofoam

3,500 V

5,000 V

14,500 V

Removing bubble pack from PCB

7,000 V

20,000 V

26,500 V

Packing PCBs in foam-lined box

5,000 V

11,000 V

21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.
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●

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

●

Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

●

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

●

Place items on a grounded surface before removing them from their container.

●

Always be properly grounded when touching a sensitive component or assembly.

●

Avoid contact with pins, leads, or circuitry.

●

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Chapter 4 Routine care, SATA drive guidelines, and disassembly preparation

Personal grounding methods and equipment
Use the following equipment to prevent static electricity damage to equipment:
●

Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

●

Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one-megohm ± 10% resistance between the operator and
ground.
Static Shielding Protection Levels
Method

Voltage

Antistatic plastic

1,500

Carbon-loaded plastic

7,500

Metallized laminate

15,000

Grounding the work area
To prevent static damage at the work area, use the following precautions:
●

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

●

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

●

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

●

Turn off power and input signals before inserting and removing connectors or test equipment.

●

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

●

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

●

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
●

Antistatic tape

●

Antistatic smocks, aprons, or sleeve protectors

●

Conductive bins and other assembly or soldering aids

Electrostatic discharge information
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●

Conductive foam

●

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

●

Static-dissipative table or floor mats with hard tie to ground

●

Field service kits

●

Static awareness labels

●

Wrist straps and footwear straps providing one-megohm +/- 10% resistance

●

Material handling packages

●

Conductive plastic bags

●

Conductive plastic tubes

●

Conductive tote boxes

●

Opaque shielding bags

●

Transparent metallized shielding bags

●

Transparent shielding tubes

Operating guidelines
To prevent overheating and to help prolong the life of the computer:
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●

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

●

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented
sides of the computer and above the monitor to permit the required airflow.

●

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

●

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

●

Never operate the computer with the cover or side panel removed.

●

Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

●

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

●

Keep liquids away from the computer and keyboard.
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●

Never cover the ventilation slots on the monitor with any type of material.

●

Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care
General cleaning safety precautions
1.

Never use solvents or flammable solutions to clean the computer.

2.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3.

Always unplug the computer when cleaning with liquids or damp cloths.

4.

Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5.

Disconnect the keyboard before cleaning it.

6.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case
Follow all safety precautions in General cleaning safety precautions on page 39 before cleaning the
computer.
To clean the computer case, follow the procedures described below:
●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

●

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

●

After cleaning, always wipe the unit with a clean, lint-free cloth.

●

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the keyboard
Follow all safety precautions in General cleaning safety precautions on page 39 before cleaning the
keyboard.
To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 39.
When cleaning debris from under the keys, review all rules in General cleaning safety precautions
on page 39 before following these procedures:

Routine care
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CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.
●

Visible debris underneath or between the keys may be removed by vacuuming or shaking.

●

Canned, pressurized air may be used to clean debris from under the keys. Caution should be used
as too much air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

●

Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor
●

Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

●

To clean the monitor body follow the procedures in Cleaning the Computer Case on page 39.

Cleaning the mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.
●

Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

●

To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 39.

Service considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power supply fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.
CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.
You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.
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Tools and software Requirements
To service the computer, you need the following:
●

Torx T-15 screwdriver

●

Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

●

Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

●

Phillips #2 screwdriver

●

Diagnostics software

●

Tamper-resistant T-15 wrench

Screws
The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with the
part that was removed, then returned to their proper locations.
CAUTION:
drives only.

Metric screws have a black finish. U.S. screws have a silver finish and are used on hard

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced.
CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.
●

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

●

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

●

Avoid dropping drives from any height onto any surface.

Service considerations
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●

If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

●

Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic damage,
refer to Electrostatic discharge information on page 35

●

Do not use excessive force when inserting a drive.

●

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium coin cell battery
The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.
See the appropriate removal and replacement chapter for the chassis you are working on in this guide
for instructions on the replacement procedures.
WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.
NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.

SATA hard drives
Serial ATA Hard Drive Characteristics

42

Number of pins/conductors in data cable

7/7

Number of pins in power cable

15

Maximum data cable length

39.37 in (100 cm)

Data interface voltage differential

400-700 mV

Drive voltages

3.3 V, 5 V, 12 V

Jumpers for configuring drive

N/A

Data transfer rate

3.0 Gb/s
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SATA hard drive cables
SATA data cable
Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.
Current HP desktop products ship with SATA 3.0 Gb/s hard drives.
SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.
The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Cable management
Always follow good cable management practices when working inside the computer.
●

Keep cables away from major heat sources like the heat sink.

●

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

●

Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

●

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

●

Some flat ribbon cables come prefolded. Never change the folds on these cables.

●

Do not bend any cable sharply. A sharp bend can break the internal wires.

●

Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

●

Never crease a SATA data cable.

●

Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

SATA hard drive cables
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5

Removal and replacement
procedures: Tower (TWR)

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.
NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly
See Routine care, SATA drive guidelines, and disassembly preparation on page 35 for initial safety
procedures.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION: Turn off the computer before disconnecting any cables.
Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

5.

As applicable, lay the computer down on its side to achieve a safe working position.
NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.
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Access panel
Description

Spare part number

Access panel

732748-001

To access internal components, you must remove the access panel:
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Lift up on the access panel handle (1) then lift the access panel off the computer (2).

Access panel
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Front bezel security
The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45)

3.

Remove the security screw from the side of the hard drive bay just behind the front panel.

4.

Install the security screw through the middle front bezel release tab to secure the front bezel in
place.
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Front bezel
Description

Spare part number

Front bezel

732751-001

Front bezel for use in China

732752-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45)

3.

Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Front bezel
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Bezel blanks
Description

Spare part number

Optical drive 5.25-inch bezel blank

732770-001

On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch drive bays that need to
be removed before installing a drive. To remove a bezel blank:
1.

Remove the access panel (Access panel on page 45)

2.

Remove the front bezel (Front bezel on page 47)

3.

Remove the bezel blank for the appropriate drive:
●

To remove a 5.25-inch bezel blank, press inward on the retaining tabs that hold the bezel
blank in place (1) then pull the bezel blank from the front bezel (2).

NOTE: After removing the 5.25-inch drive bezel blank and installing a drive, you can
install an optional bezel trim piece (available from HP) that surrounds the front of the drive.
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●

To remove a 3.5-inch bezel blank, press outward on the two retaining tabs that hold the
bezel blank in place (1) and rotate the bezel blank back and to the right to remove it (2).

●

To remove a slim optical drive bezel blank, press inward on the retaining tabs that hold the
bezel blank in place (1) then pull the bezel blank from the front bezel (2).

NOTE: After removing the slim optical drive bezel blank and installing a slim optical drive,
you can install an optional bezel trim piece (available from HP) that surrounds the front of the
slim optical drive.

Bezel blanks
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Memory
Description

Spare part number

8-GB, PC3-12800

689375-001

4-GB, PC3-12800

671613-001

2-GB, PC3-12800

671612-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3SDRAM) dual inline memory modules (DIMMs).

DIMMs
The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 32-GB of memory configured in a highperforming dual channel mode.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:
●

industry-standard 240-pin

●

unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

●

1.35 volt or 1.5 volt DDR3/DDR3L-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:
●

support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

●

contain the mandatory JEDEC SPD information

In addition, the computer supports:
●

512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

●

single-sided and double-sided DIMMs

●

DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.

Populating DIMM sockets
There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory
channel B. Sockets DIMM3 and DIMM4 operate in memory channel A.
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The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.
NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior
graphics performance.
●

The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

●

The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

●

The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. For optimal speed, the channels should
be balanced so that the largest amount of memory is spread between the two channels. If one
channel will have more memory than the other, the larger amount should be assigned to Channel
A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB DIMMs,
Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel B should
be populated with the other two 1-GB DIMMs. With this configuration, 4-GB will run as dual
channel and 1-GB will run as single channel.

●

In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.
The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.
Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.
When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45)

Memory
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3.

Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.
Populate the black DIMM sockets before the white DIMM sockets.
For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B. Refer to Populating DIMM sockets on page 50 for
more information.
4.

Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

5.

Repeat steps 3 and 4 to install any additional modules.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion cards
Description

Spare part number

nVidia Quadro NVS310 PCIe x16 graphics card, 512 MB

707252-001

nVidia Quadro NVS315 PCIe x16 graphics card, 1 GB

720837-001

AMD Radeon HD8490 PCIe x16 graphics card, 1 GB

717219-001

AMD Radeon HD8470 PCIe x16 graphics card, 2 GB DDR3

729085-001

AMD Radeon HD 8350 1GB PCIe x16 DH GFX

717220-001

GeForce GT630 PCIe x16 graphics card, 2 GB

702084-001

Intel PRO/1000 single port GbE NIC, includes bracket

728562-001

HP PCI expansion slot daughter card

696971-001

The computer has two PCI Express x1 expansion slots, one PCI Express x16 expansion slot, and one
PCI Express x16 expansion slot that is downshifted to a x4 slot. Some models also have an optional
standard PCI expansion slot.
NOTE: You can install a PCI Express x1, x8, or x16 expansion card in the PCI Express x16 slots.
For dual graphics card configurations, the first (primary) card must be installed in the PCI Express x16
slot that is NOT downshifted to a x4.
You can add the optional standard PCI expansion slot to the system board by purchasing a PCI
extender board from HP.
To remove, replace, or add an expansion card:
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45)

3.

Locate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.

Expansion cards
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4.

Press straight down on the two green thumb tabs on the exterior of the chassis (1) and rotate the
expansion card retention latch open (2).

5.

Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.
NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.
a.
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If you are installing an expansion card in a vacant socket, remove the appropriate expansion
slot cover on the back of the chassis. Lift the expansion slot cover from the expansion slot.

Chapter 5 Removal and replacement procedures: Tower (TWR)

b.

If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end
and carefully rock it back and forth until the connectors pull free from the socket. Lift the card
straight up to remove it. Be sure not to scrape the card against other components.

c.

If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Lift the card straight up to remove it. Be sure not to
scrape the card against other components.

6.

Store the removed card in anti-static packaging.

7.

If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.
CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

Expansion cards
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8.

To install a new expansion card, slide the bracket on the end of the card down into the slot on the
back of the chassis and press the card down firmly into the socket on the system board.

NOTE: When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.
9.

Close the expansion card retention latch, making sure that it snaps firmly into place.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.
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System board connections
Refer to the following illustration and table to identify the system board connectors.

No.

System Board Connector

System Board Label

Color

Component

1

System Board PCI Extender
Connectors

EXT

black

System Board PCI Extender (optional,
shown installed)

2

SATA 3.0

SATA1

light blue

Any SATA Device other than the
Primary Hard Drive

3

USB 2.0

MEDIA

black

USB 2.0 Device, such as a USB 2.0
Media Card Reader

4

SATA 3.0

SATA0

dark blue

Primary Hard Drive

5

SATA 3.0

SATA2

light blue

Any SATA Device other than the
Primary Hard Drive

6

PCI (optional)

PCI1

white

Expansion Card

7

System Board PCI Extender
(optional)

(not applicable)

(not
applicable)

Expansion Card

8

PCI Express x16 downshifted
to a x4

X4PCIEXP

white

Expansion Card

9

PCI Express x1

X1PCIEXP2

black

Expansion Card

10

PCI Express x1

X1PCIEXP1

black

Expansion Card

11

PCI Express x16

X16PCIEXP

black

Expansion Card

12

Parallel Port

PAR

black

Parallel Port

13

Serial Port

COMB

black

Serial Port

14

Hood Lock

HLCK

black

Hood Lock

15

Hood Sensor

HSENSE

white

Hood Sensor

System board connections
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No.

System Board Connector

System Board Label

Color

Component

16

Battery

BAT

black

Battery

17

DIMM4 (Channel A)

DIMM4

white

Memory Module

18

DIMM3 (Channel A)

DIMM3

black

Memory Module

19

DIMM2 (Channel B)

DIMM2

white

Memory Module

20

DIMM1 (Channel B)

DIMM1

black

Memory Module

21

Power

SATA PWR0

black

SATA Drives

22

Power

PWR

white

System Board

23

USB 3.0

FRONT USB3.0

blue

Front USB 3.0 Ports

24

USB 3.0

MEDIA3.0

black

USB 3.0 Device, such as a USB 3.0
Media Card Reader

25

SATA 3.0

SATA3

light blue

Any SATA Device other than the
Primary Hard Drive

26

SATA 3.0

SATA5

light blue

Any SATA Device other than the
Primary Hard Drive
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Drives
Description

Spare part number

Optical drives
DVD±RW drive

657958-001

DVD-ROM drive

608394-001

Blu-ray BD-RW SuperMulti XL Drive

719157-001

Hard drives
2 TB, 7200 rpm hard drive

616608-001

1 TB hard drive, hybrid SSD, 2.5-inch hard drive

724937-001

1 TB, 10000 rpm hard drive

719106-001

1 TB, 7200 rpm hard drive

613202-001

750 GB, 7200 rpm, 2.5-inch hard drive, hybrid SSD

719105-001

500 GB, 10000 rpm hard drive

683923-001

500 GB, 7200 rpm, 2.5-inch hard drive, self-encrypting (SED)

696442-001

500 GB, 7200 rpm hard drive

696442-001

500 GB hard drive, hybrid SSD, 2.5-inch hard drive

724938-001

256 GB Solid State Drive (SSD), self-encrypting (SED)

680020-001

128 GB Solid State Drive (SSD)

665961-001

32 GB mSATA drive

719566-001

32 GB mSATA drive, 2.5-inch

686616-001

When installing drives, follow these guidelines:
●

The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

●

Connect secondary hard drives and optical drives to any of the light blue SATA connectors on the
system board (labeled SATA1, SATA2, SATA3, and SATA5).

●

Connect a media card reader USB 3.0 cable to the USB connector on the system board labeled
MEDIA3.0.

●

The power cable for the drives has two branches coming off the system board connector. The first
branch is a three-headed cable with the first connector routed to the 5.25-inch bay, the second
connector routed to the 3.5-inch bay, and the third (two-wire) connector routed to the slim optical
drive bay. The second branch is a three-headed cable with the first connector routed to the bottom
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2.5-inch hard drive bay, the second connector routed to the middle 3.5-inch hard drive bay, and
the third connector routed to the top 3.5-inch hard drive bay.
●
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You must install guide screws to ensure the drive will line up correctly in the drive cage and lock in
place. HP has provided extra guide screws (four 6-32 silver and blue isolation mounting guide
screws and four silver 6-32 standard guide screws) installed on the side of the drive bays. The
6-32 isolation mounting screws are required for 3.5-inch hard drives installed in the 3.5-inch hard
drive bays. The 6-32 standard guide screws are required for a USB 3.0 media card reader
installed in the 3.5-inch optional drive bay. M3 metric guide screws for 5.25-inch optical drives
and M3 isolation mounting guide screws for 2.5-inch hard drives are not provided. If you are
replacing a drive, remove the guide screws from the old drive and install them in the new drive.

No.

Guide Screw

Device

1

Silver Standard 6-32 Guide Screws

USB 3.0 Media Card Reader

2

Silver and Blue 6-32 Isolation Mounting Screws

Secondary Hard Drive in 3.5-inch Hard Drive Bay
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CAUTION: To prevent loss of work and damage to the computer or drive:
If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.
Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.
Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.
If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”

Drive positions

1

5.25-inch half-height drive bay

2

Slim optical drive bay

3

3.5-inch drive bay for optional drive (such as a media card reader)

4

Primary 3.5-inch internal hard drive bay

5

Secondary 3.5-inch internal hard drive bay

6

Secondary 2.5-inch internal hard drive bay

NOTE:

The drive configuration on your computer may be different than the drive configuration shown above.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.
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Removing a 5.25-inch drive
NOTE: HP does not offer a 5.25-inch optical drive for this computer model. A 5.25-inch optical drive
may have been installed by the user or third-party vendor.
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44)

2.

Remove the access panel (Access panel on page 45)

3.

Remove the front bezel (Front bezel on page 47)

4.

Disconnect the power cable and data cable from the back of the drive.
CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to
avoid damaging the cable.

5.

Press down on the green drivelock mechanism (1) and slide the drive from the drive bay (2).

Installing a 5.25-inch drive
NOTE: HP does not offer a 5.25-inch optical drive for this computer model. A 5.25-inch optical drive
can be purchased through a third-party vendor.

62

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44)

2.

Remove the access panel (Access panel on page 45)

3.

Remove the front bezel (Front bezel on page 47). If you are installing a drive in a bay covered by
a bezel blank, remove the bezel blank. See Bezel blanks on page 48 for more information.
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4.

If you are installing an optical drive, install four M3 metric guide screws (not provided) in the
lower holes on each side of the drive.
NOTE: When replacing an optical drive, transfer the four M3 metric guide screws from the old
drive to the new one.
CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the
internal components of the drive.

5.

Slide the drive into the drive bay, making sure to align the guide screws with the guide slots, until
the drive snaps into place.

6.

Connect the power cable and data cable to the rear of the optical drive.
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7.

Connect the opposite end of the data cable to one of the light blue SATA connectors on the system
board.
NOTE: Refer to System board connections on page 57 for an illustration of the system board
drive connectors.

8.

Replace the front bezel.
NOTE: An optional bezel trim piece that surrounds the front of the 5.25-inch drive is available
from HP. Install the bezel trim piece in the front bezel before replacing the front bezel.

Removing a 3.5-inch device
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 44)

2.

Remove the access panel (Access panel on page 45)

3.

Remove the front bezel (Front bezel on page 47)

4.

Disconnect the drive cables from the rear of the drive, or, if you are removing a media card
reader, disconnect the USB cable from the system board as indicated in the following illustration.
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5.

Press the release lever at the rear of the drive away from the drive (1) and slide the drive from the
drive bay (2).
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Installing a 3.5-inch device
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Remove the front bezel (Front bezel on page 47). Remove the front bezel. If you are installing a
drive in a bay covered by a bezel blank, remove the bezel blank. See System board connections
on page 57 for more information.

4.

Install 6-32 guide screws in the holes on each side of the drive.
NOTE: HP has supplied four extra 6-32 guide screws on top of the drive cage. Refer to Drives
on page 59 for an illustration of the extra guide screws location.
When replacing a drive, transfer the four 6-32 guide screws from the old drive to the new one.

5.
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Slide the drive into the drive bay, making sure to align the guide screws with the guide slots, until
the drive snaps into place.
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6.

If installing a USB 3.0 media card reader, connect the USB cable from the media card reader to
the USB 3.0 connector on the system board labeled MEDIA3.0.

NOTE: Refer to System board connections on page 57 for an illustration of the system board
drive connectors.

Removing a slim optical drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44)

2.

Remove the access panel (Access panel on page 45)

3.

Remove the front bezel (Front bezel on page 47)

4.

Disconnect the power cable and data cable from the back of the drive.
CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to
avoid damaging the cable.
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5.

Push the green release lever on the right rear side of the drive toward the center of the drive (1),
then slide the drive forward and out of the bay (2).

Installing a slim optical drive
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Remove the front bezel (Front bezel on page 47). If you are installing a drive in a bay covered by
a bezel blank, remove the bezel blank. See System board connections on page 57 for more
information.

4.

Before the new optical drive can be used, the release latch must be attached.
a.

Peel the backing off the adhesive on the release latch.

b.

Without allowing the release latch to touch the optical drive, carefully align the holes on the
release latch with the pins on the side of the optical drive. Make sure the release latch is
oriented properly.

c.

Insert the pin at the front of the optical drive into the hole at the end of the release latch, and
press firmly.
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d.

Insert the second pin, and press the entire release latch firmly to fasten the latch securely to
the optical drive.

5.

Slide the optical drive through the front bezel all the way into the bay so that it locks in place.

6.

Connect the power cable and data cable to the rear of the optical drive.

7.

Connect the opposite end of the data cable to one of the light blue SATA connectors on the system
board.
NOTE: Refer to System board connections on page 57 for an illustration of the system board
drive connectors.

8.

Replace the front bezel.
NOTE: An optional bezel trim piece that surrounds the front of the slim optical drive is available
from HP. Install the bezel trim piece in the front bezel before replacing the front bezel.
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Removing a 3.5-inch or 2.5-inch hard drive
NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 44)

2.

Remove the access panel (Access panel on page 45)

3.

Disconnect the power cable (1) and data cable (2) from the back of the hard drive.
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4.

Release the drive by pulling the release tab away from the drive (1) and sliding the drive out of the
bay (2).

5.

Remove the four guide screws (two on each side) from the old drive. You will need these screws to
install a new drive.

Installing a 3.5-inch or 2.5-inch hard drive
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44)

2.

Remove the access panel (Access panel on page 45)
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3.

Install guide screws on the sides of the drive. 3.5-inch hard drives use standard 6-32 silver and
blue isolation mounting screws. 2.5-inch hard drives use metric M3 black and blue isolation
mounting screws.
NOTE: Four extra 6-32 isolation mounting guide screws for 3.5-inch hard drives are installed on
the exterior of the hard drive bays. Extra guide screws for 2.5-inch hard drives are not provided
on the chassis but can be purchased from HP. Refer to Drives on page 59 for an illustration of the
extra 6-32 isolation mounting guide screws location.
If you are replacing a drive, transfer the guides screws from the old drive to the new one.
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●

If you are installing a 3.5-inch hard drive, install four silver and blue 6-32 isolation mounting
guide screws (two on each side of the drive).

●

If you are installing a 2.5-inch hard drive, install four black and blue M3 isolation mounting
guide screws (two on each side of the drive).
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●

You can also install a 2.5-inch hard drive into a 3.5-inch drive bay using an adapter bracket
similar to the example shown below.
◦

Slide the drive into the bay adapter bracket, ensuring the connector on the drive is fully
inserted into the connector on the adapter bracket.

◦

Secure the drive to the bay adapter bracket by installing four black M3 adapter bracket
screws through the sides of the bracket into the drive.
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◦

4.
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Install four 6-32 silver and blue isolation mounting guide screws in the adapter bracket
(two on each side of the bracket).

Slide the drive into the drive bay, making sure to align the guide screws with the guide slots, until
the drive snaps into place.
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5.

Connect the power cable (1) and data cable (2) to the back of the hard drive.
NOTE: The power cable for the hard drives is a three-headed cable that is routed from the
system board to the rear of the hard drive bays.

6.

If installing a new drive, connect the opposite end of the data cable to the appropriate system
board connector.
NOTE: You must connect the primary hard drive data cable to the dark blue connector labeled
SATA0 to avoid any hard drive performance problems. If you are adding a second hard drive,
connect the data cable to one of the light blue SATA connectors.
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Front I/O assembly
Description

Spare part number

Front I/O assembly

732750-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Remove the front bezel (Front bezel on page 47).

4.

Disconnect the three front I/O cables from the following system board connectors:
●

FRONT USB

●

MEDIA 3.0

●

FRONT AUD

5.

Remove the Torx T15 screw that secures the assembly to the chassis (1).

6.

Rotate the right side of the assembly outward (2).

7.

Pull the assembly away from the computer while threading the wires through the hole in the front
of the chassis.

To reinstall the assembly, reverse the removal procedure.
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Power switch/LED assembly
Description

Spare part number

Power switch/LED assembly

732749-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Remove the front bezel (Front bezel on page 47).

4.

Disconnect the cable from the system board connector labeled PB/LED.

Power switch/LED assembly
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5.

Press down on the top of the assembly to disengage the tab that secures the assembly to the
chassis.

6.

Rotate the assembly downward to remove it from the chassis.

7.

Pull the assembly away from the chassis while threading the cable through the hole in front of the
chassis.
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Fan sink
Description

Spare part number

Fan sink (includes replacement thermal material)

727142-001

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Loosen the four silver captive Torx T15 screws that secure the heat sink to the system board.
CAUTION: Remove fan sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. The pins on the socket are very fragile and any damage to
them may require replacing the system board.

Fan sink
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4.

Disconnect the fan cable from the system board connector labeled CPUFAN (1), and then lift the
fan sink from atop the processor (2).

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heat sink on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.
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Processor
Description

Spare part number

Intel Core i7 processor (includes thermal material)
4770, 3.4 GHz, 8-MB L3 cache, 86W

727373-001

Intel Core i5 processors (include thermal material)
4670, 3.4 GHz, 6-MB L3 cache, 86W

727381-001

4570, 3.2 GHz, 6-MB L3 cache, 86W

727380-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Remove the fan sink (Fan sink on page 79).

4.

Rotate the locking lever to its full open position (1).

5.

Raise and rotate the microprocessor retainer to its fully open position (2).

6.

Carefully lift the processor from the socket (3).
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.
The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Processor
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NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://www8.hp.com/us/en/support-drivers.html.

Speaker
Description

Spare part number

Speaker (40 x 70 mm)

645330-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Disconnect the speaker wire from the system board connector labeled SPKR (1).

4.

From the inside of the chassis, remove the Torx T15 screw (2) that secures the speaker to the front
of the chassis.

5.

Rotate the top of the speaker downward (3), and then remove it from the chassis.

To replace the speaker, reverse the removal procedures.
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Smart Cover Lock (solenoid lock)
Description

Spare part number

Solenoid lock

641498-001

NOTE: The Smart Cover Lock is an optional feature included on some models only.
The Smart Cover Lock is a software-controllable cover lock, controlled by the setup password. This lock
prevents unauthorized access to the internal components. The computer ships with the Smart Cover Lock
in the unlocked position.
If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will need
a Smart Cover FailSafe Key to open the computer cover. You will need the key to access the internal
computer components in any of the following circumstances:
●

Power outage

●

Startup failure

●

PC component (for example, processor or power supply) failure

●

Forgotten password

NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order this
key before you need it.
To obtain a FailSafe Key:
●

Contact an authorized HP reseller or service provider. Order PN 166527-001 for the wrench-style
key or PN 166527-002 for the screwdriver bit key.

●

Refer to the HP Web site (http://www.hp.com) for ordering information.

●

Call the appropriate number listed in the warranty.

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

Smart Cover Lock (solenoid lock)
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3.

From the outside, rear side of the chassis, use the Smart Cover FailSafe Key to remove the tamperproof screw(s) that secure the Smart Cover Lock to the chassis.
CAUTION: After you remove the screws, the lock may fall into the computer. Hold the lock
while removing the screws to avoid damaging the lock or internal components.

4.

From the inside of the chassis, disconnect the cable (1) from the system board connector labeled
HLOCK.

5.

Remove the solenoid lock from the chassis (2).

To install the solenoid lock, reverse the removal procedure.
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Place the lock up against the tab at the top of the installation location on the rear of the chassis. From
the outside of the chassis, line up the screw holes and install both security screws. Plug the connector
into the system board connector.

Insert the cable into the clip on the back of the system board USB port. Install the clip if necessary.

NOTE: If both the hood lock and hood sensor are installed, make sure the hood sensor cable is under
the hood lock cable in the clip.

Smart Cover Lock (solenoid lock)
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Hood sensor
Description

Spare part number

Hood sensor

638816-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Disconnect the cable from the system board connector labeled HSENSE (1).

4.

Using a tool, remove the sensor from the slot by pushing it into the computer to remove it (2).

To install the hood sensor, reverse the removal procedure.
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Fan
Description

Spare part number

Fan

727135-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

From the outside, rear side of the chassis, remove the three silver Phillips screws that secure the fan
to the chassis.

4.

From the inside of the chassis, disconnect the fan control cable (1) from the system board
connector labeled CHFAN2.

Fan

87

5.

Lift the fan out of the chassis (2).

To install the fan, reverse the removal procedure. Be sure to orient the air flow out of the computer.
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Power supply
Description

Spare part number

Power supply, 320W, 92% efficient

702452-001

Power supply, 320W, 90% efficient

702453-001

Power supply, 320W

702454-001

Power supply, HV, 320W

707906-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

Disconnect the power cables from the following system board connectors:.
●

PWR

●

PWRCPU

●

PWRCMD

Power supply
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4.

Remove the power cables from the clip on the base pan.

5.

From the outside, rear of the chassis, remove the four silver Torx T15 screws that connect the
power supply to the chassis.

6.

Press the tab (1) on the base pan in front of the power supply that holds it in place.
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7.

Slide the power supply toward the front of the computer (2), rotate slightly into the computer so
the power supply clears the lip on the top of the chassis, and then lift the power supply out of the
chassis (3).

To install the power supply, reverse the removal procedure.

Power supply
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System board and PCI expansion slot daughter card
NOTE: All system board spare part kits include replacement thermal material.
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Description

Spare part number

System board for use in models without Windows 8

696969-001

System board for use in models with Windows 8 Standard

696969-501

System board for use in models with Windows 8 Professional

696969-601

System board for use in models with NetClone

727720-001

HP PCI expansion slot daughter card

696971-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 44).

2.

Remove the access panel (Access panel on page 45).

3.

When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:
●

Memory modules (Memory on page 50)

●

Expansion cards (Expansion cards on page 53)

●

Fan sink (Fan sink on page 79).

●

Processor (Processor on page 81)

4.

Disconnect all cables connected to the system board, noting their location for reinstallation.

5.

If a PCI expansion slot daughter card is installed, remove the two Torx T15 screws (1) that secure
the PCI extension board to the chassis.
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6.

Slide the board toward the side of the chassis to disengage it from the system board connector ,
and then lift the extension board from the chassis (2).

7.

Remove the eight Torx T15 screws (1) that secure the system board to the chassis.

8.

Slide the system board toward the front of the computer to disengage the I/O panel, and then lift
the system board out of the computer (2).

When reinstalling the system board, first insert the I/O panel back into the slots in the rear of the
chassis, and then align the board with the chassis screw holes.
NOTE: When replacing the system board, you must change the chassis serial number in the BIOS.

System board and PCI expansion slot daughter card
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Removal and replacement
procedures: Small Form Factor (SFF)

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.
NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly
See Routine care, SATA drive guidelines, and disassembly preparation on page 35 for initial safety
procedures.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION: Turn off the computer before disconnecting any cables.
Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

5.

If the computer is on a stand, remove the computer from the stand and lay the computer down.
NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.
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Access panel
Description

Spare part number

Access panel

732760-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Lift up on the access panel handle (1) then lift the access panel off the computer (2).

To install the access panel, reverse the removal procedure.

Access panel
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Front bezel
Description

Spare part number

Front bezel

732757-001

Optical drive bezel blank

732769-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

To install the front bezel, reverse the removal procedure.
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Front bezel security
The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 95).

4.

Remove the front bezel (Front bezel on page 96).

5.

Remove one of the five silver 6-32 standard screws located on top of the drive cage.

Front bezel security
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6.
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Install the security screw through the middle front bezel release tab to secure the front bezel in
place.
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Bezel blanks
On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:
1.

Remove the access panel (Access panel on page 95).

2.

Remove the front bezel (Front bezel on page 96).

3.

To remove a 3.5-inch bezel blank, press inward on the five retaining tabs (1) and pull the blank
off the front bezel (2).
To remove a slim optical drive bezel blank, press the two retaining tabs that hold the bezel blank
in place towards the outer right edge of the bezel (3) and slide the bezel blank back and to the
right to remove it (4).

4.

Replace the front bezel.

NOTE: After removing the slim optical drive bezel blank and installing a slim optical drive, you can
install an optional bezel trim piece (available from HP) that surrounds the front of the slim optical drive.

Bezel blanks
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Memory
Description

Spare part number

8-GB, PC3-12800

689375-001

4-GB, PC3-12800

671613-001

2-GB, PC3-12800

671612-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3SDRAM) dual inline memory modules (DIMMs).

DIMMs
The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 32-GB of memory configured in a highperforming dual channel mode.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:
●

industry-standard 240-pin

●

unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

●

1.35 volt or 1.5 volt DDR3/DDR3L-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:
●

support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

●

contain the mandatory JEDEC SPD information

In addition, the computer supports:
●

512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

●

single-sided and double-sided DIMMs

●

DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.

Populating DIMM sockets
There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory
channel B. Sockets DIMM3 and DIMM4 operate in memory channel A.
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The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.
NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior
graphics performance.
●

The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

●

The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, if Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system
will operate in dual channel mode.

●

The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. For optimal speed, the channels should
be balanced so that the largest amount of memory is spread between the two channels. If one
channel will have more memory than the other, the larger amount should be assigned to Channel
A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB DIMMs,
Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel B should
be populated with the other two 1-GB DIMMs. With this configuration, 4-GB will run as dual
channel and 1-GB will run as single channel.

●

In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.
The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.
Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.
When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Rotate up the internal drive bay housing to access the memory module sockets on the system
board.

Memory
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4.

Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.
Populate the black DIMM sockets before the white DIMM sockets.
For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B. Refer to Populating DIMM sockets on page 100
for more information.
5.

Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

6.

Repeat steps 4 and 5 to install any additional modules.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion card
Description

Spare part number

nVidia Quadro NVS310 PCIe x16 graphics card, 512 MB

707252-001

nVidia Quadro NVS315 PCIe x16 graphics card, 1 GB

720837-001

AMD Radeon HD8490 PCIe x16 graphics card, 1 GB

717219-001

AMD Radeon HD8450 PCIe x16 graphics card, 1 GB

717220-001

HP WLAN 802.11 a/b/g/n 2x2 PCIe module

695915-001

Intel PRO/1000 single port GbE NIC, includes bracket

728562-001

The computer has two PCI Express x1 expansion slots, one PCI Express x16 expansion slot, and one
PCI Express x16 expansion slot that is downshifted to a x4 slot.
NOTE: The PCI Express slots support only low profile cards.
You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slot.
For dual graphics card configurations, the first (primary) card must be installed in the PCI Express x16
slot that is NOT downshifted to a x4.
To remove, replace, or add an expansion card:
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 95).

4.

Locate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.

Expansion card
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5.

Release the slot cover retention latch that secures the slot covers by lifting the green tab on the
latch and rotating the latch to the open position.

6.

Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.
NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.
a.
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If you are installing an expansion card in a vacant socket, remove the appropriate expansion
slot cover on the back of the chassis. Pull the slot cover straight up then away from the inside
of the chassis.
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7.

b.

If you are removing a PCI Express x1 card, hold the card at each end, and carefully rock it
back and forth until the connectors pull free from the socket. Pull the expansion card straight
up from the socket (1) then away from the inside of the chassis to release it from the chassis
frame (2). Be sure not to scrape the card against the other components.

c.

If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Pull the expansion card straight up from the socket then
away from the inside of the chassis to release it from the chassis frame. Be sure not to scrape
the card against the other components.

Store the removed card in anti-static packaging.

Expansion card
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8.

If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.
CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

9.

To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis (1) so that the bracket on the card is
aligned with the open slot on the rear of the chassis. Press the card straight down into the
expansion socket on the system board (2).

NOTE: When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.
10. Rotate the slot cover retention latch back in place to secure the expansion card.
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11. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.
12. Reconfigure the computer, if necessary.

System board connections
Refer to the following illustration and table to identify the system board connectors for your model.

No.

System Board Connector

System Board Label

Color

Component

1

PCI Express x16 downshifted
to a x4

X4PCIEXP

white

Expansion Card

2

PCI Express x1

X1PCIEXP2

black

Expansion Card

3

PCI Express x1

X1PCIEXP1

black

Expansion Card

4

PCI Express x16

X16PCIEXP

black

Expansion Card

5

Parallel Port

PAR

black

Parallel Port

6

Serial Port

COMB

black

Serial Port

7

Hood Lock

HLCK

black

Hood Lock

8

Hood Sensor

HSENSE

white

Hood Sensor

9

Battery

BAT

black

Battery

10

DIMM4 (Channel A)

DIMM4

white

Memory Module

11

DIMM3 (Channel A)

DIMM3

black

Memory Module

12

DIMM2 (Channel B)

DIMM2

white

Memory Module

13

DIMM1 (Channel B)

DIMM1

black

Memory Module

14

Power

SATAPWR0

black

SATA Drives
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No.

System Board Connector

System Board Label

Color

Component

15

Power

PWR

white

System Board

16

USB 3.0

FRONT USB3.0

blue

Front USB 3.0 Ports

17

USB 3.0

MEDIA3.0

black

USB 3.0 Device, such as a USB 3.0
Media Card Reader

18

SATA 3.0

SATA0

dark blue

Primary Hard Drive

19

SATA 3.0

SATA1

light blue

Any SATA Device other than the
Primary Hard Drive

20

SATA 3.0

SATA2

light blue

Any SATA Device other than the
Primary Hard Drive

21

USB 2.0

MEDIA

black

USB 2.0 Device, such as a USB 2.0
Media Card Reader

Drives
Description

Spare part number

Optical drives
DVD±RW drive

657958-001

DVD-ROM drive

608394-001

Blu-ray BD-RW SuperMulti XL Drive

719157-001

Hard drives
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2 TB, 7200 rpm hard drive

616608-001

1 TB hard drive, hybrid SSD, 2.5-inch hard drive

724937-001

1 TB, 10000 rpm hard drive

719106-001

1 TB, 7200 rpm hard drive

613202-001

750 GB, 7200 rpm, 2.5-inch hard drive, hybrid SSD, 2.5-inch hard drive

719105-001

500 GB, 10000 rpm hard drive

683923-001

500 GB, 7200 rpm hard drive, self-encrypting (SED)

696442-001

500 GB hard drive, hybrid SSD, 2.5-inch hard drive

724938-001

256 GB Solid State Drive (SSD), self-encrypting (SED)

680020-001

128 GB Solid State Drive (SSD)

665961-001

32 GB mSATA drive, 2.5-inch

686616-001

32 GB mSATA drive

719566-001
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When installing drives, follow these guidelines:
●

The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

●

Connect secondary hard drives and optical drives to one of the light blue SATA connectors on the
system board (labeled SATA1 and SATA2).

●

Connect a media card reader USB 3.0 cable to the USB connector on the system board labeled
MEDIA3.0.

●

The power cable for the drives has two branches coming off the system board connector. The first
branch is a dual-headed cable with the first connector (four-wire) routed to the 3.5-inch optional
drive bay and the second connector (two-wire) routed to the slim optical drive bay. The second
branch is a dual-headed cable with the first connector routed to the 3.5-inch hard drive bay and
the second connector routed to the 2.5-inch hard drive bay.

●

You must install guide screws to ensure the drive will line up correctly in the drive cage and lock in
place. HP has provided four extra 6-32 standard guide screws installed on the top of the drive
bay. The 6-32 standard guide screws are required for a media card reader or a secondary hard
drive installed in the 3.5-inch optional drive bay. M3 isolation mounting guide screws for 2.5-inch
hard drives are not provided. If you are replacing a drive, remove the guide screws from the old
drive and install them in the new drive.

There are a total of five extra silver 6-32 standard screws. One is used for bezel security (1) (see Front
bezel security on page 97 for more information). The other four are used as guide screws for a media
card reader or a secondary hard drive in the 3.5-inch optional drive bay (2).

Drives
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CAUTION: To prevent loss of work and damage to the computer or drive:
If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.
Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.
Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.
If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”

Drive positions

1

Slim optical drive bay

2

3.5-inch internal hard drive bay

3

3.5-inch drive bay for optional drives (media card reader shown)

4

2.5-inch internal hard drive bay

NOTE: The drive configuration on your computer may be different than the drive
configuration shown above.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.
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Removing a 3.5-inch device
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Remove the front bezel (Front bezel on page 96).

4.

Rotate the drive cage to its upright position.

5.

Disconnect the drive cables from the rear of the drive, or, if you are removing a media card
reader, disconnect the USB cable from the system board as indicated in the following illustration.

6.

Press inward on the release lever at the rear of the drive (1) and slide the drive out of the rear of
the drive bay (2).

Drives
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Installing a 3.5-inch device
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Remove the front bezel (Front bezel on page 96). If you are installing a drive in a bay covered by
a bezel blank, remove the bezel blank. See Bezel blanks on page 99 for more information.

4.

Install 6-32 guide screws in the holes on each side of the drive.
NOTE: HP has supplied four extra 6-32 guide screws on top of the drive cage. Refer to Drives
on page 108 for an illustration of the extra guide screws location.
When replacing a drive, transfer the four 6-32 guide screws from the old drive to the new one.
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5.

Rotate the drive cage to its upright position.

6.

Slide the drive into the drive bay, making sure to align the guide screws with the guide slots, until
the drive snaps into place.
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7.

If installing a USB 3.0 media card reader, connect the USB cable from the media card reader to
the USB 3.0 connector on the system board labeled MEDIA3.0.

NOTE: Refer to System board connections on page 107 for an illustration of the system board
drive connectors.
8.

Rotate the drive cage back down to its normal position.
CAUTION:

Be careful not to pinch any cables or wires when rotating the drive cage down.

Drives
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Removing a slim optical drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Disconnect the power cable (1) and data cable (2) from the rear of the optical drive, push the
green release latch on the right rear side of the drive toward the center of the drive (3), then slide
the drive forward and out of the bay through the front bezel (4).
CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to
avoid damaging the cable.
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Installing a slim optical drive
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 95).

4.

Remove the front bezel (Front bezel on page 96) if you are installing a drive in a bay covered by
a bezel blank, then remove the bezel blank. See Bezel blanks on page 99 for more information.

5.

Before the new optical drive can be used, the release latch must be attached.
a.

Peel the backing off the adhesive on the release latch.

b.

Without allowing the release latch to touch the optical drive, carefully align the holes on the
release latch with the pins on the side of the optical drive. Make sure the release latch is
oriented properly.

c.

Insert the pin at the front of the optical drive into the hole at the end of the release latch, and
press firmly.

d.

Insert the second pin, and press the entire release latch firmly to fasten the latch securely to
the optical drive.
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6.

Slide the optical drive through the front bezel all the way into the bay so that it locks in place (1),
then connect the power cable (2) and data cable (3) to the rear of the drive.

7.

Connect the opposite end of the data cable to one of the light blue SATA connectors on the system
board.
NOTE: Refer to System board connections on page 107 for an illustration of the system board
drive connectors.

8.

Replace the front bezel if it was removed.
NOTE: An optional bezel trim piece that surrounds the front of the optical drive is available from
HP. Install the bezel trim piece in the front bezel before installing the front bezel.

Removing and replacing a 3.5-inch hard drive
NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 95).

4.

Disconnect the power cable and data cable from the back of the hard drive.
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5.

Pull the release lever next to the rear of the hard drive outward (1). While pulling the release lever
out, slide the drive back until it stops, then lift the drive up and out of the bay (2).

6.

To install a hard drive, you must transfer the silver and blue isolation mounting guide screws from
the old hard drive to the new hard drive.

Drives
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7.

Align the guide screws with the slots on the chassis drive cage, press the hard drive down into the
bay, then slide it forward until it stops and locks in place.

8.

Connect the power cable and data cable to the back of the hard drive.
NOTE: The data cable for the primary hard drive must be connected to the dark blue connector
labeled SATA0 on the system board to avoid any hard drive performance problems.

9.

Replace the access panel.

10. If the computer was on a stand, replace the stand.
11. Reconnect the power cord and turn on the computer.
12. Lock any security devices that were disengaged when the access panel was removed.
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Removing a 2.5-inch hard drive
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Rotate the drive cage to its upright position.

4.

Disconnect the power cable and data cable from the back of the hard drive.

5.

Pull outward on the release lever at the rear of the drive (1) then slide the drive back until it stops
and pull it down and out of the drive bay (2).

Installing a 2.5-inch hard drive
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

If the computer is on a stand, remove the computer from the stand.

3.

Remove the access panel (Access panel on page 95).
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4.

Install four black and blue M3 isolation mounting guide screws (two on each side of the drive).
NOTE: M3 metric isolation mounting guide screws can be purchased from HP.
When replacing a drive, transfer the four M3 isolation mounting guide screws from the old drive
to the new one.

5.

Rotate the drive cage to its upright position.

6.

Align the guide screws on the drive with the J-slots on the sides of the drive bay. Press the drive up
into the drive bay then slide it forward until it locks in place.

7.

Connect the power cable and data cable to the back of the hard drive.
NOTE: If the 2.5-inch hard drive is the primary drive, connect the data cable to the dark blue
SATA connector labeled SATA0 on the system board. If it is a secondary drive, connect the data
cable to one of the light blue SATA connectors on the system board.

8.

Rotate the drive cage back down to its normal position.
CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.
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Power supply
Description

Spare part number

Power supply, 92% efficient

702455-001

Power supply, 90% efficient

702456-001

Power supply, standard

702457-001

WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.
The power supply is located at the rear of the chassis. It is held in place by three Torx screws outside of
the chassis and a release lever inside of the chassis.
WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Rotate the drive cage to the upright position.

4.

Disconnect all power cables from the following system board connectors:
●

PWRCPU

●

PWRCMD

●

PWR

Power supply
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5.
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Release the power supply cables from the cable retaining clip under the drive cage.
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6.

From the outside, rear of the computer, remove the three Torx screws that secure the power supply
to the rear of the chassis.

7.

From the inside of the chassis, press the release button at the front of the power supply (1).

8.

Slide the power supply forward (2), and then lift it out of the chassis (3).

To install the power supply, reverse the removal procedure.
CAUTION: When installing the power supply cables, make sure they are properly positioned in the
clip under the drive cage.

Power supply
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Fan duct
Description

Spare part number

Fan duct

727145-001

The fan duct sits between the front fan and the heat sink.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Rotate the fan duct upward.

4.

Pull the duct away from the chassis to disengage the clips on the duct from the chassis.

To install the fan duct, reverse the removal procedure.
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Smart Cover Lock (solenoid lock)
Description

Spare part number

Solenoid lock

732772-001

NOTE: The Smart Cover Lock is an optional feature included on some models only.
The Smart Cover Lock is a software-controllable cover lock, controlled by the setup password. This lock
prevents unauthorized access to the internal components. The computer ships with the Smart Cover Lock
in the unlocked position.
If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will need
a Smart Cover FailSafe Key to open the computer cover. You will need the key to access the internal
computer components in any of the following circumstances:
●

Power outage

●

Startup failure

●

PC component (for example, processor or power supply) failure

●

Forgotten password

NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order this
key before you need it.
To obtain a FailSafe Key:
●

Contact an authorized HP reseller or service provider. Order PN 166527-001 for the wrench-style
key or PN 166527-002 for the screwdriver bit key.

●

Refer to the HP Web site (http://www.hp.com) for ordering information.

●

Call the appropriate number listed in the warranty.

The solenoid lock is mounted to the back of the computer. Remove it using one security screw on the
outside of the computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

Smart Cover Lock (solenoid lock)
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3.

From the outside, rear side of the chassis, remove the silver security screw that secures the
solenoid lock to the chassis.

4.

From the inside of the chassis, disconnect the cable (1) from the system board connector labeled
HLOCK.

5.

Remove the solenoid lock from the chassis (2).

To install the solenoid lock, reverse the removal procedure.
Refer to the following image for the location of the slots on the back of the chassis in which to install the
solenoid lock. When installing, insert the top tabs into the top slots, and then rotate the lock downward.
Then install the security screw on the outside of the computer. Plug the connector into the system board
connector.
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Smart Cover Lock (solenoid lock)
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Hood sensor
Description

Spare part number

Hood sensor

638816-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Disconnect the cable from the system board connector labeled HSENSE (1).

4.

Using a tool, remove the sensor from the slot by pushing it into the computer to remove it (2).

To install the hood sensor, reverse the removal procedure.
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Cable routing
Use the following image to determine proper cable routing in the Small Form Factor computer.

Cable routing
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Front I/O assembly
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Description

Spare part number

Front I/O assembly

732755-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Remove the front bezel (Front bezel on page 96).

4.

Rotate the drive cage to its upright position.

5.

Disconnect the cables from the system board as follows:
●

Yellow connector labeled FRONT_USB

●

Black connector labeled MEDIA 3.0

●

Blue connector labeled FRONT AUD
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6.

Remove the cables from the cable clip under the drive cage.

7.

Remove the Torx T15 screw (1) that secures the assembly to the front of the chassis.

8.

Press the tab on the right side of the assembly (2) to disengage it from the chassis.

9.

Push the assembly into the chassis (3), and remove it from the chassis.

To install the front I/O assembly, reverse the removal procedure.
NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly.
Proper cable routing prevents damage to the cables and allows the drive cage to close properly. See
Cable routing on page 129 for proper cable placement.

Front I/O assembly
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Power switch assembly
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Description

Spare part number

Power switch assembly

732756-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Remove the front bezel (Front bezel on page 96).

4.

Rotate the drive cage to its upright position.

5.

Disconnect the cable from the system board connector labeled PB/LED.
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6.

Remove the cable from the cable clip under the drive cage.

7.

From the inside of the chassis, press down on the tab on the top of the power switch (1) to
disengage the power switch from the chassis.

8.

Pull the power switch out the front of the chassis (2), while routing the cable through the hole in
the chassis.

To install the power switch assembly, reverse the removal procedure.
NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly.
Proper cable routing prevents damage to the cables and allows the drive cage to close properly. See
Cable routing on page 129 for proper cable placement.

Power switch assembly
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Speaker
Description

Spare part number

Speaker

727149-001

The speaker is attached to the front of the chassis under the rotating drive cage.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Remove the front bezel (Front bezel on page 96).

4.

Rotate the drive cage to its upright position.

5.

Disconnect the speaker wire from the white system board connector labeled SPKR.

6.

Remove the two Torx screws that secure the speaker to the chassis.

7.

Lift the speaker from the inside of the chassis to remove it.

To install the speaker, reverse the removal procedures.
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Fan sink
Description

Spare part number

Fan sink

727150-001

The fan sink is secured atop the processor with four captive Torx screws. The fan sink includes a heat
sink and a fan.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Remove the fan duct (Fan duct on page 124).

4.

Loosen the four captive Torx T15 screws that secure the fan sink to the system board tray.
CAUTION: Remove fan sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.

Fan sink

135

5.

Disconnect the fan cable from the system board connector labeled CPUFAN (1), and then lift the
heat sink from atop the processor (2).

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.
CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the fan sink on the processor to avoid damage that could require replacing the system
board.
Make sure to replace the fan duct. Failure to install the fan duct may cause the computer to overheat.

Processor
Description

Spare part number

Intel Core i7 processor (includes thermal material)
4770, 3.4 GHz, 8-MB L3 cache, 86W

727373-001

Intel Core i5 processors (include thermal material)
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4670, 3.4 GHz, 6-MB L3 cache, 86W

727381-001

4570, 3.2 GHz, 6-MB L3 cache, 86W

727380-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

Remove the fan duct (Fan duct on page 124).

4.

Remove the fan sink (Fan sink on page 135).
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5.

Rotate the locking lever to its full open position (1).

6.

Raise and rotate the microprocessor retainer to its fully open position (2).

7.

Carefully lift the processor from the socket (3).
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.
The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://www8.hp.com/us/en/support-drivers.html.

Processor
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System board
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Description

Spare part number

System board for use in models without Windows 8 (includes thermal material)

717522–001

System board for use in models with Windows 8 Standard (includes thermal material)

717522–501

System board for use in models with Windows 8 Professional (includes thermal material)

717522–601

System board for use in models with NetClone (includes thermal material)

727722–001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).

3.

When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:
●

Memory modules (Memory on page 100)

●

Expansion cards (Expansion card on page 103)

●

Fan sink (Fan sink on page 135)

●

Processor (Processor on page 136)

4.

Remove the fan duct from the chassis (Fan duct on page 124).

5.

Rotate the drive cage to its upright position.

6.

Disconnect all data and power cables from the system board.

7.

Remove the eight Torx screws (1) that secure the system board to the chassis.
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8.

Slide the system board toward the front of the chassis to disengage the connectors (2), and then
lift the system board up and out of the chassis (3).

To install the system board, reverse the removal procedure.
NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.
CAUTION: When reconnecting the cables it is important that they be positioned correctly.

System board
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Changing from desktop to tower configuration
The Small Form Factor computer can be used in a tower orientation with an optional tower stand that
can be purchased from HP.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Orient the computer so that its right side is facing down and place the computer in the optional
stand.

NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the optional
tower stand.
3.

Reconnect the power cord and any external devices, then turn on the computer.
NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains
clear and free of obstructions.
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7

Removal and replacement
procedures: Ultra-slim Desktop
(USDT)

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.
NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly
See Routine care, SATA drive guidelines, and disassembly preparation on page 35 for initial safety
procedures.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION:

Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.
5.

If the computer is on a stand, remove the computer from the stand and lay the computer down.
NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

Preparation for disassembly
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Access panel
Description

Spare part number

Access panel

732763-001

To access internal components, you must remove the access panel:
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Loosen the thumbscrew on the rear of the computer (1), slide the access panel toward the rear of
the computer, then lift it off (2).

To install the access panel, reverse the removal procedure.
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Front bezel
Description

Spare part number

Front bezel

732764-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

To install the front bezel, reverse the removal procedure.

Front bezel
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Front bezel security
The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the front bezel (Front bezel on page 143).

4.

Remove the black screw on the front of the chassis behind the bezel. The screw is located next to
the optical drive and is labeled "BEZEL."

5.

Replace the front bezel.

6.

Install the security screw through the middle front bezel release tab and into the chassis to secure
the front bezel in place.
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Bezel blank
Description

Spare part number

Optical drive bezel blank

732771-001

On some models, there is a bezel blank covering the slim optical drive bay that needs to be removed
before installing a slim optical drive. To remove a bezel blank:
1.

Remove the access panel (Access panel on page 142).

2.

Remove the front bezel (Front bezel on page 143).

3.

To remove the bezel blank, press inward on the six retaining tabs (1) and pull the blank off the
front bezel (2).

NOTE: After removing the slim optical drive bezel blank and installing a slim optical drive, you
can install an optional bezel trim piece (available from HP) that surrounds the front of the slim
optical drive.

Bezel blank
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System board connections
Refer to the following illustration and table to identify the system board connectors.
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No.

System Board Connector

System Board Label

Color

Component

1

Mini PCI Express x1

X1PCIEXP1

black

Expansion Card (for example, WLAN
card)

2

Mini-SATA

mSATA

white

Ultra-Small SSD

3

Hood Lock

HLOCK

black

Hood Lock

4

SATA 3.0

SATA1

light blue

Optical Drive

5

Battery

BAT

black

Battery

6

Power

SATA PWR1

white

Optical Drive

7

Mobile PCI Express Module

MXM

black

Graphics Card

8

Hood Sensor

HSENSE

white

Hood Sensor

9

USB 3.0

MEDIA 3.0

black

SD Media Card Reader
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Memory
Description

Spare part number

8-GB, PC3-12800, SODIMM

689374-001

4-GB, PC3-12800, SODIMM

689373-001

2-GB, PC3-12800, SODIMM

689372-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3SDRAM) small outline dual inline memory modules (SODIMMs).

SODIMMs
The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 16-GB of memory.

DDR3-SDRAM SODIMMs
For proper system operation, the SODIMMs must be:
●

industry-standard 204-pin

●

unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

●

1.35 volt or 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:
●

support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

●

contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:
●

512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

●

single-sided and double-sided SODIMMS

●

SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported SODIMMs.

Memory
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Populating SODIMM sockets
There are two SODIMM sockets on the system board, with one socket per channel. The sockets are
labeled DIMM1 and DIMM3. The DIMM1 socket operates in memory channel B. The DIMM3 socket
operates in memory channel A.

Item

Description

System Board Label

Socket Color

1

SODIMM1 socket, Channel B

DIMM1

Black

2

SODIMM3 socket, Channel A

DIMM3

Black

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed.
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●

The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

●

The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

●

The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. If one channel will have more memory than the
other, the larger amount should be assigned to channel A.

●

In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.
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Installing SODIMMs
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.
The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.
Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. For more information, refer to Electrostatic discharge information on page 35.
When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Locate the memory module sockets on the system board.
WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.

4.

To remove a SODIMM, press outward on the two latches on each side of the SODIMM (1) then
pull the SODIMM out of the socket (2).

To install memory modules, reverse the removal procedure.
The computer automatically recognizes the additional memory when you turn on the computer.

Memory
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Front fan
Description

Spare part number

Front fan

732765-001

The front fan sits against the front on the left side of the chassis.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Disconnect the fan control cable from the red system board connector labeled CHFAN (1).

4.

Lift the fan straight up and out of the chassis (2).

To install the front fan, reverse the removal procedure.
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Optical drive
The Ultra-Slim Desktop uses a slimline Serial ATA (SATA) optical drive.
Description

Spare part number

DVD-ROM drive

608394-001

DVD±RW drive

657958-001

Blu-ray BD-RW SuperMulti XL Drive

719157-001

Removing the optical drive
CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the front bezel (Front bezel on page 143).

4.

Disconnect the cables on the rear of the optical drive (1), push the green release latch on the right
rear side of the drive toward the center of the drive (2), then slide the drive forward and out of the
bay through the front bezel (3).
CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to
avoid damaging the cable.

Optical drive
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Preparing the new optical drive
Before the new optical drive can be used, the release latch must be attached.
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1.

Peel the backing off the adhesive on the release latch.

2.

Without allowing the release latch to touch the optical drive, carefully align the holes on the
release latch with the pins on the side of the optical drive. Make sure the release latch is oriented
properly.

3.

Insert the pin at the front of the optical drive into the hole at the end of the release latch, and press
firmly.

4.

Insert the second pin, and press the entire release latch firmly to fasten the latch securely to the
optical drive.
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Installing the new optical drive
NOTE: If you are installing an optical drive in a bay that did not previously have a drive in it, you
must remove the access panel and the bezel blank covering the opening of the bay before proceeding.
Follow the procedures in Access panel on page 142 and Bezel blank on page 145.
1.

Follow the instructions for removing the optical drive. Refer to Removing the optical drive
on page 151.

2.

Attach the release latch to the new optical drive. Refer to Preparing the new optical drive
on page 152.

3.

Slide the optical drive through the front bezel all the way into the bay so that it locks in place (1),
then connect the cable to the rear of the drive (2).

Optical drive
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Hard drive
Description

Spare part number

750 GB, 7200 rpm, hybrid SSD

719105-001

500 GB, 7200 rpm, self-encrypting (SED)

696442-001

500 GB, 7200 rpm

686217-001

320 GB, 7200 rpm

639135-001

500 GB, hybrid SSD

724938-001

256 GB Solid State Drive (SSD), self-encrypting (SED)

680020-001

128 GB Solid State Drive (SSD)

665961-001

32 MB mSATA drive

719566-001

NOTE: The Ultra-Slim Desktop supports only 2.5-inch Serial ATA (SATA) internal hard drives.
Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.
The 2.5-inch hard drive is enclosed in a carrier under the optical drive.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the optical drive (Removing the optical drive on page 151).

4.

Press in the release latch on the left side of the hard drive carrier (1) then rotate the carrier handle
up (2).
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5.

Lift the hard drive carrier straight up and out of the chassis.

6.

Remove the four guide screws from the sides of the hard drive carrier.

7.

Lift the hard drive up to the top of the carrier (1) and slide the drive out of the carrier (2).

Hard drive

155

To replace the hard drive, reverse the removal procedures.
When replacing the hard drive, position the hard drive so that the top of the hard drive is up against
the top of the carrier so that the circuit board on the bottom of the hard drive does not come in contact
with the tabs on the bottom of the carrier, then slide the new hard drive into the carrier.
CAUTION: Do not allow the circuit board on the bottom of the hard drive to scrape along the tabs
on the bottom of the carrier when sliding the hard drive into the carrier. Doing so can cause irreparable
damage to the hard drive.

Speaker
Description

Spare part number

Speaker

689384-001

The speaker is secured to the front of the chassis between the fan and the I/O ports. Remove the screws
from the outside and then remove the speaker from the inside.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the front bezel (Front bezel on page 143).

4.

Disconnect the speaker cable from the white system board connector labeled SPKR.

5.

On the outside of the chassis, remove the two Torx T8 screws that secure the speaker to the
chassis (1), and then from the inside of the chassis, slide the speaker up to remove it (2).

To install the speaker, reverse the removal procedure.

156

Chapter 7 Removal and replacement procedures: Ultra-slim Desktop (USDT)

Heat sink
Description

Spare part number

Heat sink

587456-001

The heat sink is secured by four Torx screws. It does not have an attached fan.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Lift the front fan up and place it on top of the optical drive to access the front bezel release tabs.
You do not need to disconnect the fan cable from the system board.

4.

Loosen the four Torx T15 screws that secure the heat sink to the system board, and then lift the
heat sink from the system board.

CAUTION: Heat sink retaining screws should be removed in diagonally opposite pairs (as in an
X) to even the downward forces on the processor to avoid damage that could require replacing
the system board.
5.

Lay the heat sink on its top in a safe area to prevent the thermal grease from contaminating the
work surface.

If reusing the existing heat sink go to step 1.

Heat sink
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If using a new heat sink, go to step 3.
1.

If reusing the existing heat sink, clean bottom of the heat sink and apply the thermal material
provided in the spares kit to the top of the processor.

2.

Position the heat sink atop the processor.

3.

If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

4.

Secure the heat sink to the system board and system board tray with the 4 captive screws.
CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.
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Processor
Description

Spare part number

Intel Core i7 4770s, 3.4 GHz, 8-MB L3 cache (includes thermal material)

732507-001

Intel Core i5 4670s, 3.1 GHz, 6-MB L3 cache (includes thermal material)

732506-001

Intel Core i5 4570s, 2.9 GHz, 6-MB L3 cache (includes thermal material)

732505-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the heat sink (Heat sink on page 157).

4.

Rotate the processor locking lever to its full open position (1).

5.

Raise and rotate the microprocessor retainer to its fully open position (2).

6.

Carefully lift the processor from the socket (3).
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

To install the processor, reverse the removal procedures.
NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://www8.hp.com/us/en/support-drivers.html.

Processor
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Smart Cover Lock (solenoid lock)
Description

Spare part number

Solenoid lock

732772-001

NOTE: The Smart Cover Lock is an optional feature included on some models only.
The Smart Cover Lock is a software-controllable cover lock, controlled by the setup password. This lock
prevents unauthorized access to the internal components. The computer ships with the Smart Cover Lock
in the unlocked position.
If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will need
a Smart Cover FailSafe Key to open the computer cover. You will need the key to access the internal
computer components in any of the following circumstances:
●

Power outage

●

Startup failure

●

PC component (for example, processor or power supply) failure

●

Forgotten password

NOTE: The Smart Cover FailSafe Key is a specialized tool available from HP. Be prepared; order this
key before you need it.
To obtain a FailSafe Key:
●

Contact an authorized HP reseller or service provider. Order PN 166527-001 for the wrench-style
key or PN 166527-002 for the screwdriver bit key.

●

Refer to the HP Web site (http://www.hp.com) for ordering information.

●

Call the appropriate number listed in the warranty.

The solenoid lock is mounted to the back of the computer. Remove it using one security screw on the
outside of the computer.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 94).

2.

Remove the access panel (Access panel on page 95).
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3.

From the outside, rear side of the chassis, remove the silver security screw that secures the lock to
the chassis.

4.

From the inside of the chassis, lift the lock up to gain access to the system board connector.

Smart Cover Lock (solenoid lock)
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5.

Disconnect the cable from the system board connector labeled HLOCK.

To install the Smart Cover Lock, reverse the removal procedure.
Refer to the following image for the location of the slots on the back of the chassis in which to install the
lock. When installing, insert the top tabs into the top slots, and then rotate the lock downward. Then
install the security screw on the outside of the computer. Plug the connector into the system board
connector.
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Smart Cover Lock (solenoid lock)
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Drive cage
Description

Spare part number

Optical disc drive mounting cage

732761-001

The drive cage sits behind the USB ports on the front of the chassis.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the optical drive (Removing the optical drive on page 151).

4.

Remove the hard drive (Hard drive on page 154).

5.

Remove the two Torx screws that secure cage to the chassis (1), lift the tab (2) on the cage, slide
the cage toward the rear of the unit (3), and then pull the cage up and out of the chassis.

To install the drive cage, reverse the removal procedures.
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Hood sensor
Description

Spare part number

Hood sensor

638816-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the optical drive (Removing the optical drive on page 151).

4.

Remove the hard drive (Hard drive on page 154).

5.

Remove the drive cage (Drive cage on page 164).

6.

Remove the optical drive (Removing the optical drive on page 151).

7.

Unplug the hood sensor cable from the white system board connector labeled HSENSE (1) and
remove the cable from the white clip mounted on the inside chassis wall (2).

8.

Slide the hood sensor into the chassis to remove it from its slot (3). Disengaging the hood sensor
from the chassis may require use of a screwdriver or similar tool.

To install the hood sensor, reverse the removal procedures.

Hood sensor
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Card reader
Description

Spare part number

Card reader, UHS-I

716390-001

Card reader, UHS-II

736299-001

The card reader is secured to the front right corner of the chassis.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the front bezel (Front bezel on page 143).

4.

Remove the optical drive (Removing the optical drive on page 151).

5.

Remove the hard drive (Hard drive on page 154).

6.

Remove the drive cage (Drive cage on page 164).

7.

Disconnect the cable from the system board connector labeled MEDIA.

8.

On the outside of the chassis, remove the one Torx screw that secures the card reader to the
chassis.
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9.

Pull the reader away from the front of the chassis while threading the cable through the slot in the
front of the chassis.

To install the card reader, reverse the removal procedure.

Card reader
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WLAN module
Description

Spare part number

HP WLAN 802.11 a/b/g/n 2x2 PCIe NIC

695915-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the optical drive (Removing the optical drive on page 151).

4.

Remove the hard drive (Hard drive on page 154).

5.

Remove the drive cage (Drive cage on page 164).

6.

Disconnect the two antenna cables from the connectors on the module (1).

7.

Remove the two Phillips screws (2) that secure the module to the system board.

8.

Lift the module to a 45 degree angle, and then remove the module from the connector by pulling it
away at an angle (3).

To install the WLAN module, reverse the removal procedure. Make sure the antenna cables are
correctly routed.
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Graphics board
Description

Spare part number

AMD Radeon HD 7650A 2GB MXM Graphics

708866-001

CAUTION: Be very careful when removing or replacing the system board to prevent damaging it.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the optical drive (Removing the optical drive on page 151).

4.

Remove the hard drive (Hard drive on page 154).

5.

Remove the drive cage (Drive cage on page 164).

6.

Remove the two Torx T8 screws (1) that secure the graphics board to the system board, rotate the
board upward to a 45-degree angle (2), and the pull it away from the system board connector
and out of the computer (3).
NOTE: Graphics card appearance may vary.

To install the graphics board, reverse the removal procedure.
If you need to remove the heat sink from the graphics board, loosen the four captive Torx screws that
secure the heat sink from the graphics board, and then lift the heat sink from the graphics board.

Graphics board
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Power switch
Description

Spare part number

Power switch

732767-001

1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the front bezel (Front bezel on page 143).

4.

Remove the optical drive (Removing the optical drive on page 151).

5.

Remove the hard drive (Hard drive on page 154).

6.

Remove the drive cage (Drive cage on page 164).

7.

Disconnect the power switch cable from the system board connector labeled PB/LED.

8.

Remove the power switch cable from atop the front I/O bracket.

9.

From the front of the computer, press down (or squeeze) on the top on the power switch (1), and
then rotate it down (2) to disengage it from the chassis.

10. Pull the power switch and cable assembly out through the hole in the front of the chassis.
To install the power switch, reverse the removal procedure.
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System board
Description

Spare part number

System board for use in models without Windows 8

696970-001

System board for use in models with Windows 8 Standard

696970-501

System board for use in models with Windows 8 Professional

696970-601

System board for use in NetClone models

727721-001

Front I/O panel

732762-001

CAUTION: Be very careful when removing or replacing the system board to prevent damaging it.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the memory modules (Memory on page 147).

4.

Remove the front fan (Front fan on page 150).

5.

Remove the optical drive (Removing the optical drive on page 151).

6.

Remove the hard drive (Hard drive on page 154).

7.

Remove the drive cage (Drive cage on page 164).

8.

Remove the heat sink (Heat sink on page 157).

9.

Disconnect the rear fan cable from the system board.

10. Remove the power button cable from atop the front I/O panel.
11. Disconnect any remaining cables connected to the system board, noting their location for
reinstallation.
12. Remove the front I/O panel:
a.

Remove the Torx T15 screw from the right side of the panel that secures it to the front of the
chassis.

System board
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b.

Press the tab on right side of the panel (1), and then swing the right side of the cage away
from the chassis to remove it (2).

13. Remove the three remaining Torx T15 screws that secure the system board to the chassis.

14. Slide system board toward the front of the unit until the rear connectors are clear of their slots in
the chassis (1).
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15. Lift the rear of the system board until it clears the chassis, and then remove the system board from
the chassis (2).

To install the system board, reverse the removal procedure.
NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

Rear fan
Description

Spare part number

Rear fan

732766-001

The rear fan is secured to the rear right corner of the chassis. You must remove the system board before
you can remove the rear fan.
1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the optical drive (Removing the optical drive on page 151).

4.

Remove the front fan (Front fan on page 150).

5.

Remove the hard drive (Hard drive on page 154).

6.

Remove the drive cage (Drive cage on page 164).

7.

Remove the heat sink (Heat sink on page 157).

8.

Remove the system board (System board on page 171).

Rear fan
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9.

From the outside of the chassis, remove the four Phillips screws that secure the fan to the chassis.

10. From the inside of the chassis, slide the fan out from underneath the chassis lip, and then remove
the fan.

To install the rear fan, reverse the removal procedure.

Antennas
Two antennas are secured to chassis – one on the front, one on the back. You must remove all other
components to remove the antennas.
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1.

Prepare the computer for disassembly (Preparation for disassembly on page 141).

2.

Remove the access panel (Access panel on page 142).

3.

Remove the optical drive (Removing the optical drive on page 151).

4.

Remove the front fan (Front fan on page 150).

5.

Remove the hard drive (Hard drive on page 154).
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6.

Remove the drive cage (Drive cage on page 164).

7.

Remove the heat sink (Heat sink on page 157).

8.

Remove the system board (System board on page 171).

9.

Remove the rear fan (Rear fan on page 173).

10. To remove the front antenna, from the inside of the front of the chassis, remove the antenna from
the clips built into the base pan.

11. From the outside of the front of the chassis, remove the two Torx T8 screws (1) that secure the
antenna to the chassis.

Antennas
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12. Pull the antenna out of the clips on the front of the chassis (2), and then pull the antenna out of the
hole it routes through (3).

13. To remove the rear antenna, from the inside of the front of the chassis, remove the antenna from
the plastic clips attached to the side of the chassis.
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14. From the outside of the rear of the chassis, remove the two Torx T8 screws that secure the antenna
to the chassis.

15. Pull the antenna through the hole it routes through.

To install the rear fan, reverse the removal procedure.

Antennas
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Changing from desktop to tower configuration
The Ultra-slim Desktop can be used in a tower orientation with the tower stand included with the
computer.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5.

Orient the computer so that its left side is facing down and place the computer firmly down into
the stand.

6.

Reconnect the external equipment, plug the power cord into a power outlet, and turn the computer
on.
NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains
clear and free of obstructions.

NOTE: An optional Quick Release mounting bracket is available from HP for mounting the computer
to a wall, desk, or swing arm. When the mounting bracket is used, do not install the computer with the
I/O ports oriented towards the ground.
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Port cover
Description

Spare part number

Port cover

588981-001

An optional rear port cover is available for the computer.
To install the port cover:
1.

Thread the cables through the bottom hole on the port cover (1) and connect the cables to the rear
ports on the computer.

2.

Insert the hooks on the port cover into the slots on the rear of the chassis, then slide the cover to
the right to secure it in place (2).

NOTE: For security purposes, you can install an optional cable lock to the chassis that locks the port
cover and secures the computer.
The port cover is secured in place by a retention lever just inside the port cover opening. To remove the
port cover, pull the lever back towards the port cover opening (1), then slide the cover to the left and
off the computer (2).

Power supply, external
The USDT chassis uses an external power supply.
WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

Port cover
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Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:
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●

Change factory default settings.

●

Set the system date and time.

●

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

●

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

●

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:
❑

always Quick Boot (default);

❑

periodically Full Boot (from every 1 to 30 days); or

❑

always Full Boot.

●

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

●

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

●

Enter the Asset Tag or property identification number assigned by the company to this computer.

●

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

●

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

●

Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.
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●

Enable or disable removable media boot ability.

●

Solve system configuration errors detected but not automatically fixed during the Power-On SelfTest (POST).

●

Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

●

Execute self-tests on a specified ATA hard drive (when supported by drive).

●

Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities
Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:
1.

Turn on or restart the computer.

2.

Repeatedly press F10 when the monitor light turns green to access the utility.
You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.
NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

4.

Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

5.

To apply and save changes, select File > Save Changes and Exit.
●

If you have made changes that you do not want applied, select Ignore Changes and
Exit.

●

To reset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models
CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only after
exiting the F10 Setup screen.

Computer Setup (F10) Utilities

181

Computer Setup—File
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Table 8-1 Computer Setup—File
Option

Description

System Information

Lists:
●

Product name

●

SKU number

●

Processor type/speed/stepping

●

Cache size (L1/L2/L3) (dual core processors have this listed twice)

●

Installed memory size/speed, number of channels (single or dual) (if applicable)

●

Integrated MAC address for embedded, enabled NIC (if applicable)

●

System BIOS (includes family name and version)

●

Chassis serial number

●

Asset tracking number

●

ME firmware version

●

ME Management mode

About

Displays copyright notice.

Set Time and Date

Allows you to set system time and date.

Flash System ROM

Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup

Save to Removable Media
Saves system configuration to a formatted USB flash media device.
Restore from Removable Media
Restores system configuration from a USB flash media device.

Default Setup

Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default
Restores the factory system configuration settings as the default.
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Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Table 8-2 Computer Setup—Storage
Option

Description

Device
Configuration

Lists all installed BIOS-controlled storage devices.
When a device is selected, detailed information and options are displayed. The following options
may be presented:
●

Hard Disk: Size, model, firmware version, serial number, connector color.

●

CD-ROM: Model, firmware version, serial number, connector color (not included for USB CDROM).

●

SMART (ATA disks only)

●

Diskette: Model and firmware version.

NOTE:

Displays for USB diskette drives.

Computer Setup (F10) Utilities

183

Table 8-2 Computer Setup—Storage (continued)
Storage Options

SATA Emulation
Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are three supported options: IDE, RAID, and AHCI (default).
CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.
IDE - This is the most backwards-compatible setting of the three options. Operating systems usually
do not require additional driver support in IDE mode.
RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.
AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.
NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID.
Removable Media Boot
Enables/disables ability to boot the system from removable media. Default is enabled.

Boot Order

Allows you to:
●

EFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard drive,
USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included
for consideration as a bootable operating system source.
EFI boot sources always have precedence over legacy boot sources.

●

Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded from
or included for consideration as a bootable operating system source.
Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.
You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.
NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system
has started.
Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Table 8-3 Computer Setup—Security
Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.
NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On
Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle or reboot. If the user does not enter the correct power-on password, the unit will not
boot.

Password Options

Allows you to enable/disable:

(This selection appears
only if a power-on
password or setup
password is set.)

●

Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel ports).

●

Stringent security (enabling the stringent password disables the ability to reset the password by
moving the jumper on the system board). Default is disabled.
CAUTION: If you enable the stringent security feature and you forget the setup password or
the power-on password, the computer is inaccessible and can no longer be used.
If you lose or forget the password, the system board must be replaced. This scenario is not
covered under warranty.
To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

Smart Cover

●

Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

●

Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is
enabled.

●

Network Server Mode. Default is disabled.

Allows you to:
●

Lock/unlock the Cover Lock.

●

Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been removed.
Setup Password requires that the setup password be entered to boot the computer if the sensor
detects that the cover has been removed.
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Table 8-3 Computer Setup—Security (continued)
Device Security

Allows you to set Device Available/Device Hidden (default is Device Available) for:
●

Embedded security device

●

System audio

●

USB controller (varies by model)

●

Network controller
NOTE:

USB Security
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You must disable AMT before trying to hide the network controller.

●

Serial port

●

Parallel port

●

SATA ports (varies by model)

Allows you to set Enabled/Disabled (default is Enabled) for:
●

Front USB Ports

●

Rear USB Ports

●

Accessory USB Ports

Slot Security

Allows you to disable any PCI or PCI Express slot. Default is enabled.

Network Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs

Allows you to set:
●

Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

●

Ownership tag (80-byte identifier) displayed during POST.

●

Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are used
to uniquely identify the system.)

●

Keyboard locale setting for System ID entry.
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Table 8-3 Computer Setup—Security (continued)
Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.
The MBR contains information needed to successfully boot from a disk and to access the data stored
on the disk. Master Boot Record Security may prevent unintentional or malicious changes to the
MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities. It also
allows you to recover the "last known good" MBR, should changes to the MBR be detected when
the system is restarted.
When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.
NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS
cannot prevent changes that may occur while the operating system is running.
Restores the backup Master Boot Record to the current bootable disk. Default is disabled.
Only appears if all of the following conditions are true:
●

MBR security is enabled

●

A backup copy of the MBR has been previously saved

●

The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified
the MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved
MBR if you are confident that the current bootable disk's MBR has been corrupted or infected with a
virus.
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Table 8-3 Computer Setup—Security (continued)
System Security
(these options are
hardware dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.
SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.
Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on. Default is
disabled.
Virtualization Technology Directed I/O (VTd) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and then
back on. Default is disabled.
Trusted Execution Technology (enable/disable) - Controls the underlying processor and chipset
features needed to support a virtual appliance. Changing this setting requires turning the computer
off and then back on. Default is disabled. To enable this feature you must enable the following
features:
●

Embedded Security Device Support

●

Virtualization Technology

●

Virtualization Technology Directed I/O

Embedded Security Device (enable/disable) - Permits activation and deactivation of the Embedded
Security Device.
NOTE:
●

To configure the Embedded Security Device, a Setup password must be set.

Reset to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all
security keys and leave the device in a disabled state. Changing this setting requires that you
restart the computer. Default is Do not reset.
CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

●
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Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path and
saves collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker tracks
changes to any of these metrics, and forces the user to re-authenticate if it detects any
changes. Enabling this feature lets you set Bitlocker to ignore detected changes to boot path
metrics, thereby avoiding re-authentication issues associated with USB keys inserted in a port.
Default is enabled.
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Table 8-3 Computer Setup—Security (continued)
System Security
(continued)

OS management of Embedded Security Device (enable/disable) - This option allows the user to limit
OS control of the Embedded Security Device. Default is enabled. This option is automatically
disabled if Trusted Execution Technology is enabled.
●

Reset of Embedded Security Device through OS (enable/disable) - This option allows the user
to limit the operating system ability to request a Reset to Factory Settings of the Embedded
Security Device. Default is disabled.
NOTE:

●

No PPI provisioning (Windows 8 only) - This option lets you set Windows 8 to bypass the PPI
(Physical Presence Interface) requirement and directly enable and take ownership of the TPM
on first boot. You cannot change this setting after TPM is owned/initialized, unless the TPM is
reset. Default is disabled for non-Windows 8 systems, and enabled for Windows 8.

●

Allow PPI policy to be changed by OS. Enabling this option allows the operating system to
execute TPM operations without Physical Presence Interface. Default is disabled.
NOTE:

DriveLock Security

To enable this option, a Setup password must be set.

To enable this option, a Setup password must be set.

Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither is
successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.
NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.

Secure Boot
Configuration

This is a feature of Windows 8.
●

Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so
on. If set to disable, legacy boot options in Storage > Boot Order are not displayed.
Default is enabled.

●

Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate
before booting to it, making Windows resistant to malicious modification from preboot to full
OS booting, preventing firmware attacks. UEFI and Windows Secure Boot only allow code
signed by pre-approved digital certificates to run during the firmware and OS boot process.
Default is disabled, except for Windows 8 systems which have this setting enabled. Secure
Boot enabled also sets Legacy Support to disabled.

●

Key Management—This option lets you manage the custom key settings.
◦

Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded
custom boot keys. Default is Don't Clear.

◦

Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify
the contents of the secure boot signature databases and the platform key (PK) that verifies
kernels during system start up, allowing you to use alternative operating systems.
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Table 8-3 Computer Setup—Security (continued)
Selecting HP Keys causes the computer boot using the preloaded HP-specific boot keys.
Default is HP Keys.
●

Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f
keys to access items before the operating system loads. Default is disabled.
NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically
and display advanced boot options.
From Windows 8, you can press Shift and select Restart to access the screen that lets you
boot to a device or troubleshoot your computer.

Computer Setup—Power
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Table 8-4 Computer Setup—Power
Option

Description

OS Power
Management

●

Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

●

Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

●

Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern.
Default is disabled.
NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4
state, not the S5 state.
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◦

S0 (On) = Solid white LED.

◦

S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(white LED) — repeated cycles of 3 blinks and a pause.

◦

S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(white LED) — repeated cycles of 4 blinks and a pause.

◦

S5 (Soft Off) = LED is off.
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Table 8-4 Computer Setup—Power (continued)
Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.
S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.
PCI Express x16 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets you
set lower power modes that activate when the bus is not being used. Options are Disabled, LOs,
L1, LOs and L1. Default is ASPM Disabled.
PCI Express x1 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets you set
lower power modes that activate when the bus is not being used. Options are Disabled, LOs, L1,
LOs and L1. Default is ASPM Disabled.
Network Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.
USB 3.0 Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

Thermal

Fan idle mode—This bar graph controls the minimum permitted fan speed.
NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Table 8-5 Computer Setup—Advanced (for advanced users)
Option

Heading

Power-On Options

Allows you to set:
●

POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).
◦

QuickBoot (default) = Do not clear memory or perform a memory test.

◦

FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦

Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦

FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

●

POST messages (enable/disable). Enabling this feature will cause the system to display POST
error messages, which are error messages displayed on the monitor during the Power On Self
Test if the BIOS encounters some kind of problem while starting the PC. A POST error message
will only display on screen if the computer is capable of booting this far. If the POST detects
an error before this point, a beep code is generated instead. Default is disabled.

●

Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of the
text “Press the ESC key for Startup Menu” during POST. This text does not display on
Windows 8 systems with Fast Boot support. Other text also will not display (for example,
Ownership Tag). Default is enabled.

●

Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. Default is enabled.

●

After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
◦

Power off—causes the computer to remain powered off when power is restored.

◦

Power on—causes the computer to power on automatically as soon as power is restored.

◦

Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.
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●

POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST delay
also gives you more time to select F10 to enter Computer (F10) Setup. Default is None.

●

Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

●

Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

●

Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the computer
not to confirm when changes were made. Default is disabled.
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Table 8-5 Computer Setup—Advanced (for advanced users) (continued)
BIOS Power-On

Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices

Allows you to set resources for or disable Legacy devices.
Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all
operating systems. To hide a device from the operating system, see Security > Device Security.

Bus Options

Device Options

Allows you to enable or disable:
●

PCI SERR# Generation. Default is enabled.

●

PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Allows you to set:
●

Printer mode (Bi-Directional, EPP + ECP, Output Only). ECP = Enhanced Capabilities Port, EPP
= Enhanced Parallel Port. Default is EPP+ECP.

●

Num Lock State at Power-On (off/on). Default is off.

●

Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

●

Integrated Graphics (Auto/Disable/Force) Use this option to manage integrated (UMA)
graphics memory allocation. The value you choose is allocated permanently to graphics and is
unavailable to the operating system. For example, if you set this value to 512M on a system
with 2 GB of RAM, the system always allocates 512 MB for graphics and the other 1.5 GB for
use by the BIOS and operating system. Default is Auto which sets memory allocation to 512
MB.
If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA
memory size allocation between 32 MB and 1 GB.

●

Internal Speaker (does not affect external speakers). Default is enabled.

●

NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded
NIC option ROM to allow the unit to boot through the network to a PXE server. This is typically
used to download a corporate image to a hard drive. The NIC option ROM takes up memory
space below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This space
is limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. The default will be to have the NIC option-ROM-enabled. Default is PXE.

●

SATA RAID Option ROM Download (enable/disable). The BIOS contains an embedded SATA
RAID option ROM for RAID support. This can be temporarily disabled to save DCH space.
Note that with the option ROM disabled, users will be unable to boot to hard drives in the
system while running in RAID mode. Default is disabled.

●

Multi-Processor (enable/disable). Use this option to disable multi-processor support under the
OS. Default is enabled.

●

Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

●

Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,
which allows one core of the system to run at a higher than standard frequency and power if
other cores are idle. Default is enabled.
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Table 8-5 Computer Setup—Advanced (for advanced users) (continued)
VGA Configuration

Displayed only if there is an add-in video card in the system. Allows you to specify which VGA
controller will be the “boot” or primary VGA controller.

AMT Configuration

Allows you to set:
●

AMT (enable/disable). Allows you to enable or disable functions of the embedded
Management Engine (ME) such as Active Management Technology (AMT). If set to disable, the
Management Engine is set to a temporarily disabled state and will not provide functions
beyond necessary system configuration. Default is enabled.

●

Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned
management settings for AMT. The AMT settings are restored to factory defaults. This feature
should be used with caution as AMT will not be able to provide any set AMT management
functions once unconfigured. Default is disabled.

●

Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to
not display the confirmation to unconfigure ME.

●

Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system
and BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is
deactivated by BIOS and would indicate that a halt occurred during execution if the alert is
sent to the management console. An operating system alert is deactivated by the operating
system image and would indicate that a hang occurred during its initialization. Default is
enabled.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File
on page 182 in the Computer Setup—File table.)
NOTE: It is recommended that you save any modified computer configuration settings to a USB flash
media device and save the device for possible future use.
To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility.
(See Computer Setup—File on page 182 in the Computer Setup—File table.)
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9

Troubleshooting without
diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices,
hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems
with the computer, refer to the tables in this chapter for probable causes and recommended solutions.
NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST error messages on page 236.

Safety and comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.
●

Run the HP diagnostic tool.

●

Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 180
for more information.

●

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST error messages
on page 236 for more information.

●

If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

●

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

●

If you recently added new hardware, remove the hardware and see if the computer functions
properly.

Safety and comfort
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●

If you recently installed new software, uninstall the software and see if the computer functions
properly.

●

Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

●

Refer to the comprehensive online technical support at http://www.hp.com/support.

●

Refer to Helpful hints on page 196 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.
Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.
If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:
●

Be in front of your computer when you call.

●

Write down the computer serial number, product ID number, and monitor serial number before
calling.

●

Spend time troubleshooting the problem with the service technician.

●

Remove any hardware that was recently added to your system.

●

Remove any software that was recently installed.

●

Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.
NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:
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●

Check that the computer and monitor are plugged into a working electrical outlet.

●

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

●

Check that the computer is turned on and the white power light is on.

●

Check that the monitor is turned on and the green monitor light is on.
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●

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST error messages
on page 236 for more information.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

●

Check all cable connections for loose connections or incorrect connections.

●

Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

●

Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 220 for instructions.

●

Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

●

Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

●

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

●

If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the other
monitor connectors are disabled and if the monitor is connected into these ports, the monitor will
not function. You can select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage
applied to the system board. You must disconnect the power cord from the power source before
opening the computer to prevent system board or component damage.

Helpful hints
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Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,
contact an authorized dealer or reseller.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
Computer appears locked up and will not turn off when the power button is pressed.
Cause

Solution

Software control of the power switch is not functional.

1.

Press and hold the power button for at least four seconds
until the computer turns off.

2.

Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.
Cause

Solution

Computer is in Sleep state.

To resume from Sleep state, press the power button.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

System has locked up.

Restart computer.

Computer date and time display is incorrect.
Cause

Solution

RTC (real-time clock) battery may need to be replaced.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on installing
a new battery, or contact an authorized dealer or reseller for
RTC battery replacement.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.
To access Control Panel in Windows 8, from the Start screen,
type c, and then select Control Panel from the list of
applications.
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Cursor will not move using the arrow keys on the keypad.
Cause

Solution

The Num Lock key is turned on.

Press the Num Lock key. The Num Lock light must be off if you
want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.
Cause

Solution

System volume may be set low or muted.

1.

Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does not
affect the external speakers).

2.

Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3.

Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.
Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.
In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock .
A key to unlock the Smart Cover Lock is not available from
HP. Keys are typically available from a hardware store.

Poor performance.
Cause

Solution

Processor is too hot.

1.

Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2.

Make sure fans are connected and working properly
(some fans only operate when needed).

3.

Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the
hard drive.

Low on memory.

Add more memory.
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Poor performance.
Cause

Solution

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

Windows 7:
1.

Close unnecessary applications to free up memory.

2.

Add more memory.

3.

Some applications run in the background and can be
closed by right-clicking on their corresponding icons in
the task tray. To prevent these applications from
launching at startup:
In Windows 7:
a.

Go to Start > All Programs > Accessories >
Run

b.

Type msconfig, and then press Enter.

c.

On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

In Windows 8:

Some software applications, especially games, are stressful on
the graphics subsystem.

Cause unknown.
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a.

On the Start screen, right-click, and then select the
All apps icon.

b.

Under Windows System, click Run.

c.

Type msconfig, and then press Enter.

d.

On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

1.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2.

Add more memory.

3.

Upgrade the graphics solution.

Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing).
Cause

Solution

Processor thermal protection activated:

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2.

Open the access panel, press the power button, and see
if the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

3.

If fan a plugged in and not spinning, replace it.

A fan may be blocked or not turning.
OR
The heat sink is not properly attached to the processor.

System does not power on and the LEDs on the front of the computer are not flashing.
Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:
1.

If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power supply)
is set to the appropriate voltage. Proper voltage setting
depends on your region.

2.

Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3.

Replace the system board.

OR
Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:
1.

Check that the unit is plugged into a working AC outlet.

2.

Open the access panel and check that the power button
cable is properly connected to the system board.

3.

Check that the power supply cables are properly
connected to the system board.

4.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

5.

If the 5V_aux light on the system board is off, then
replace the power supply.

6.

Replace the system board.
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Solving power problems
Common causes and solutions for power problems are listed in the following table.
Power supply shuts down intermittently.
Cause

Solution

If equipped with a voltage selector, voltage selector switch on
rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing.)
Cause

Solution

Processor thermal protection activated:

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2.

Open the access panel, press the power button, and see
if the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

3.

If fan a plugged in and not spinning, replace it.

A fan may be blocked or not turning.
OR
The heat sink is not properly attached to the processor.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the
computer beeps four times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Power failure (power supply is overloaded).

1.

If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set to the appropriate voltage. Proper
voltage setting depends on your region.

2.

Open the access panel and ensure the power supply
cable is seated into the connector on the system board.

3.

Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If the
system enters POST, then power off and replace one
device at a time and repeat this procedure until failure
occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all
devices are functioning properly.

4.

Replace the power supply.

5.

Replace the system board.

The incorrect external power supply adapter is being used on
the All-in One or USDT.

The power supply adapter must be at the correct power rating
and use the Smart ID technology before the system will power
up. Replace the power supply adapter with the HP-supplied
power supply adapter.
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Solving hard drive problems
Hard drive error occurs.
Cause

Solution

Hard disk has bad sectors or has failed.

1.

In Windows 7, click Start, click Computer, and rightclick on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.
In Windows 8, on the Start screen type e, and then
select File Explorer from the list of applications. In the
left column, expand Computer, right-click on a drive,
select Properties, and then select the Tools tab. Under
Error checking click Check.

2.

Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.
Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and rightclick on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.
In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column,
expand Computer, right-click on a drive, select Properties,
and then select the Tools tab. Under Error checking click
Check.

Drive not found (identified).
Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 220 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.
If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > PowerOn Options.
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Drive not found (identified).
Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.
Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1.

Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1.

Insert bootable media and restart the computer.

2.

Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3.

Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.
Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1.

Check SATA cable connections.

2.

Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.
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Computer will not boot from hard drive.
Cause

Solution

Hard Drive's “Emulation Type” is set to “None.” (some
models)

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST error messages
on page 236 to determine possible causes for the blinking
red and beep codes.
See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.
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Cause

Solution

Program in use has stopped responding to commands.

1.

Use the task manager to close programs that do not
respond.

2.

Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Solving media card reader problems
Media card will not work in a digital camera after formatting it in Windows.
Cause

Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Some
digital cameras use the FAT (FAT16 & FAT12) format and can
not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with
Windows.

A write-protected or locked error occurs when attempting to write to the media card.
Cause

Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.
Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.
Cause

Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted
properly.
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Do not know how to remove a media card correctly.
Cause

Solution

The computer’s software is used to safely eject the card.

In Windows 7, click Start, select Computer, right-click on
the corresponding drive icon, and then select Eject. Pull the
card out of the slot.
In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer,
right-click on the corresponding drive icon, and then select
Eject. Pull the card out of the slot.
NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are
not recognized by the computer.
Cause

Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.
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Cause

Solution

The inserted media card has boot capability.

1.

If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserted media card during the boot process.

2.

During POST (Power On Self-Test), press F9 to modify the
boot menu.

3.

Change the boot sequence in F10 Computer Setup.
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Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.
Blank screen (no video).
Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan
rate as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the
monitor.

1.

In Control Panel, select Category from the View by
list, then under Appearance and Personalization,
select Adjust screen resolution.
To access Control Panel in Windows 7, click Start, and
then select Control Panel.
To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the
list of applications.

2.
Monitor is configured to use an input that is not active.

Expand the Resolution box, and then use the sliding
control to reset the resolution.

Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.
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Blank screen and the power LED flashes Red five times, once every second, followed by a two second
pause, and the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Pre-video memory error.

1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty
module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second
pause, and the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Pre-video graphics error.

For systems with a graphics card:
1.

Reseat the graphics card (if applicable). Power on the
system.

2.

Replace the graphics card (if applicable).

3.

Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second
pause, and the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.
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Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.
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Dim characters.
Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.

Blurry video or requested resolution cannot be set.
Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.
Cause

Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1.

Be sure the monitor cable is securely connected to the
computer.

2.

In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3.

Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.
Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.
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“No Connection, Check Signal Cable” displays on screen.
Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.
CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.
Cause

Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so that
the new settings take effect.
To enter Safe Mode in Windows 7:
1.

Restart the computer.

2.

Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

3.

On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

4.

Log on to your computer with a user account that has
administrator rights.
When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

To enter Safe Mode in Windows 8:
1.

Press the Windows logo + l to open the Settings charm.

2.

Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3.

Select Troubleshoot, select Advanced options,
select Startup Settings, and then click Restart.

4.

Use the function keys or number keys to select the safe
mode option you want.
When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.
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High pitched noise coming from inside a flat panel monitor.
Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or
unable to center the picture on the screen (flat panel monitors using an analog VGA input connection
only).
Cause

Solution

Flat panel monitor’s internal digital conversion circuits may be
unable to correctly interpret the output synchronization of the
graphics card.

1.

Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2.

Manually synchronize the Clock and Clock Phase onscreen display functions. To download a SoftPaq that will
assist you with the synchronization, go to the following
Web site, select the appropriate monitor, and download
either SP32347 or SP32202: http://www.hp.com/
support

Graphics card is not seated properly or is bad (some models).

1.

Reseat the graphics card.

2.

Replace the graphics card.

Certain typed symbols do not appear correct.
Cause

Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
into a document.
In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.
In Windows 8, on the Start screen, type ch, and then select
Character Map from the list of applications.

Solving display problems

213

Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.
Sound cuts in and out.
Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.
Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.
NOTE: In Windows 8, the taskbar is available at the bottom
of the Desktop screen.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged into the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Internal speaker is disabled in Computer Setup.
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Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

Sound does not come out of the speaker or headphones.
Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.
Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.
Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.
Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.
Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.
Printer will not print.
Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1.

Install the correct printer driver for the application.

2.

Try printing using the MS-DOS command:

DIR C:\ > [printer port]
where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.
To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.
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If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.
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Printer will not turn on.
Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.
Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.
Cause

Solution

The printer may be out of paper.

Check the paper tray and refill it if it is empty.
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Solving keyboard and mouse problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.
A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement,
jumpy mouse/keyboard, or no function of mouse/keyboard and external drive.
Cause

Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard USB
receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.
Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep date, do
not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.

218

Cause

Solution

The Num Lock key is on.

Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.
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Mouse does not respond to movement or is too slow.
Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:
1.

Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2.

Use the arrow keys to select Shut Down and then press
Enter.

3.

After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Windows 8:
1.

Press the Windows logo + l to open the Settings charm.

2.

Use the arrow keys to select Power, and then press
Enter.

3.

Use the arrow keys to select Shut Down, and then
press Enter.

4.

After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.
Cause

Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.
To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
Table 9-1 Solving Hardware Installation Problems
A new device is not recognized as part of the system.
Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup.
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Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.

Computer will not start.
Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1.

Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.
NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be installed
before DIMM2, and DIMM3 must be installed before
DIMM4.

2.

Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3.

If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.
1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty
module.
NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be installed
before DIMM2, and DIMM3 must be installed before
DIMM4

3.

Replace third-party memory with HP memory.

4.

Replace the system board.
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Power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Graphics card (some models) is not seated properly or is bad,
or system board is bad.

For systems with a graphics card:
1.

Reseat the graphics card. Power on the system.

2.

Replace the graphics card.

3.

Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer
beeps ten times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Bad option card.

1.

Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see if
fault goes away.

2.

Once bad card is identified, remove and replace bad
option card.

3.

Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.
Table 9-2 Solving Network Problems
Wake-on-LAN feature is not functioning.
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Cause

Solution

S5 Maximum Power Saving feature is enabled.

Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management
> S5 Maximum Power Savings.
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Table 9-2 Solving Network Problems (continued)
Wake-on-LAN feature is not functioning.
Cause

Solution

S5 Wake on LAN is disabled (some models).

Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on
LAN.

Wake-on-LAN is not enabled.

To enable Wake-on-LAN in Windows 7:
1.

Select Start > Control Panel > Network and
Sharing Center.

2.

Under Tasks, select Manage network
connections.

3.

Click Local Area Connection.

4.

Click the Properties button.

5.

Click the Configure button.

6.

Click the Power Management tab, then select
Allow this device to wake the computer.

To enable Wake-on-LAN in Windows 8:
1.

From the Start screen, type c, and then select Control
Panel from the list of applications.

2.

Select Network and Sharing Center, and then click
the Ethernet link next to the connection.

3.

Click the Properties button.

4.

Click the Configure button.

5.

Click the Power Management tab, then enable the
appropriate Wake-on LAN option.
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Network driver does not detect network controller.
Cause

Solution

Network controller is disabled.

1.

Run Computer Setup and enable network controller.

2.

Enable the network controller in the operating system
using Device Manager.
To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.
NOTE:

The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network controller is disabled.

1.

Run Computer Setup and enable network controller.

2.

Enable the network controller in the operating system
using Device Manager.
To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.
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Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.
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Diagnostics reports a failure.
Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.
Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.
Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the
Control Panel and configure the network controller.
To access Control Panel in Windows 7, click Start, and then
select Control Panel.
To access Control Panel in Windows 8, from the Start screen,
type c, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.
Cause

Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.
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Network controller stops working without apparent cause.
Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 8.
If necessary, download the softpaq from the web (from a
different computer).

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective.

Contact an authorized service provider.

New network card will not boot.
Cause

Solution

New network card may be defective or may not meet industrystandard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.
Cause

Solution

The network controller is not configured properly.

Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.
Cause

Solution

Unprogrammed EEPROM.

Contact an authorized service provider.

Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.
CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must
unplug the computer power cord before attempting to reseat, install, or remove a memory module.
For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.
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NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dualchannel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), thirdparty data storage, and other management functions.
System will not boot or does not function properly after installing additional memory modules.
Cause

Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.
Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.
Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.
Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add
more memory to the computer.

Solving memory problems
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Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Memory is installed incorrectly or is bad.

1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty
module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Solving processor problems
If you encounter processor problems, common causes and solutions are listed in the following table.
Poor performance is experienced.
Cause

Solution

Processor is hot.

1.

Make sure the airflow to the computer is not blocked.

2.

Make sure the fans are connected and working properly
(some fans only operate when needed).

3.

Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.
Cause

Solution

Processor is not seated properly or not installed.

1.

Check to see that the processor is present.

2.

Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.
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Cause

Solution

The current processor does not support a feature previously
enabled on this system.

1.

Install a TXT (Trusted Execution Technology) capable
processor.

2.

Disable TXT in the Computer Setup (F10) utility.

3.

Reinstall the original processor.
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Solving CD-ROM and DVD problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.
System will not boot from CD-ROM or DVD drive.
Cause

Solution

The device is attached to a SATA port that has been hidden in
the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).
Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 220 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.
If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > PowerOn Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.
Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Solving CD-ROM and DVD problems
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Movie will not play in the DVD drive.
Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).
Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.
Cause

Solution

Media is corrupt.

Try different media to confirm whether media is valid.

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine
the type of media being played. If the disc still does not start,
read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1.

Use Device Manager to remove or uninstall the device.
To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

2.
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Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.
Cause

Solution

Wrong or poor quality media type.

1.

Try using a slower speed when recording.

2.

Verify that you are using the correct media for the drive.

3.

Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.
USB flash drive is not seen as a drive letter in Windows.
Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).
Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in
Security > USB Security.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.
Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.
Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.

Flash drive is defective.

Try a different flash drive.

Solving USB flash drive problems
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Solving front panel component problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.
A USB device, headphone, or microphone is not recognized by the computer.
Cause

Solution

Device is not properly connected.

1.

Turn off the computer.

2.

Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed.

1.

Install the correct driver for the device.

2.

You might need to reboot the computer.

1.

If possible, replace the cable.

2.

Restart the computer.

1.

Replace the device.

2.

Restart the computer.

The cable from the device to the computer does not work.

The device is not working.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports
are set to Enabled in Security > USB Security.

Solving Internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.
Unable to connect to the Internet.
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Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)
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Unable to connect to the Internet.
Cause

Solution

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will
be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser remember
some specific information that the Web server can later
retrieve.)

Windows 7:
1.

Select Start > Control Panel.

2.

Click Internet Options.

3.

In the Browsing history section on the General tab,
click the Delete button.

4.

Select the Cookies check box and click the Delete
button.

Windows 8:
1.

From the Start screen, type c, and then select Control
Panel from the list of applications..

2.

Click Internet Options.

3.

In the Browsing history section on the General tab,
click the Delete button.

4.

Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.
Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.

Solving Internet access problems
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Solving software problems
Most software problems occur as a result of the following:
●

The application was not installed or configured correctly.

●

There is insufficient memory available to run the application.

●

There is a conflict between applications.

●

Be sure that all the needed device drivers have been installed.

●

If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.
Computer will not continue and the HP logo does not display.
Cause

Solution

ROM issue - POST error has occurred.

Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST error messages
on page 236 to determine possible causes.
See the Worldwide Limited Warranty for terms and
conditions.
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Computer will not continue after HP logo screen displays.
Cause

Solution

System files may be damaged.

In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system repair
disc that contains the System Recovery Options menu. If the
problem is severe enough that Startup Repair doesn't start on
its own and you can't access the System Recovery Options
menu on your computer's hard disk, you can get to the menu
and start Startup Repair by using the Windows installation
disc or a system repair disc that you created earlier.
In Windows 8, use Automatic Repair to fix problems that
might prevent Windows from starting correctly.
To access Automatic Repair:
1.

Press the Windows logo + l to open the Settings charm.

2.

Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3.

Select Troubleshoot, select Advanced options, and
then select Automatic Repair.
Windows starts Automatic Repair.

4.

Select the account to use to begin Automatic Repair, and
type the password for the account.
Windows diagnoses the computer and attempts the
repair it.

“Illegal Operation has Occurred” error message is displayed.
Cause

Solution

Software being used is not Microsoft-certified for your version
of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.

Solving software problems
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10 POST error messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.
POST Message Disabled suppresses most system messages during POST, such as memory count and
non-error text messages. If a POST error occurs, the screen will display the error message. To manually
switch to the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12).
The default mode is POST Message Disabled.
The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.
Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory
test. Full Boot runs all of the ROM-based system tests and takes longer to complete.
Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.
NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 180.
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POST numeric codes and text messages
This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.
NOTE: The computer will beep once after a POST text message is displayed on the screen.
Control panel message

Description

Recommended action

101-Option ROM Checksum Error

System ROM or expansion board option
ROM checksum.

1.

Verify the correct ROM.

2.

Flash the ROM if needed.

3.

If an expansion board was recently
added, remove it to see if the problem
remains.

4.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

5.

If the message disappears, there may
be a problem with the expansion card.

6.

Replace the system board.

1.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

2.

Remove expansion boards.

3.

Replace the system board.

1.

If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2.

In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the internal
NIC from being downloaded during
POST to free more memory for an
expansion card's option ROM. Internal
PXE option ROM is used for booting
from the NIC to a PXE server.

103-System Board Failure

110-Out of Memory Space for Option ROMs

162-System Options Not Set

DMA or timers.

Recently added PCI expansion card contains
an option ROM too large to download
during POST.

Configuration incorrect.
RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.
Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.
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Control panel message

Description

Recommended action

163-Time & Date Not Set

Invalid time or date in configuration memory.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

RTC (real-time clock) battery may need to
be replaced.

163-Time & Date Not Set

CMOS jumper may not be properly installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error

Memory configuration incorrect.

1.

Run Computer Setup or Windows
utilities.

2.

Make sure the memory module(s) are
installed properly.

3.

If third-party memory has been added,
test using HP-only memory.

4.

Verify proper memory module type.

1.

Ensure memory modules are correctly
installed.

2.

Verify proper memory module type.

3.

Remove and replace the identified
faulty memory module(s).

4.

If the error persists after replacing
memory modules, replace the system
board.

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1.

Verify proper memory module type.

2.

Try another memory socket.

3.

Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1.

If additional memory was recently
added, remove it to see if the problem
remains.

2.

Check product documentation for
memory support information.

201-Memory Error

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...
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Control panel message

Description

Recommended action

301-Keyboard Error

Keyboard failure.

1.

Reconnect keyboard with computer
turned off.

2.

Check connector for bent or missing
pins.

3.

Ensure that none of the keys are
depressed.

4.

Replace keyboard.

1.

Reconnect keyboard with computer
turned off.

2.

Replace the system board.

1.

Reconnect the keyboard with computer
turned off.

2.

Ensure that none of the keys are
depressed.

3.

Replace the keyboard.

4.

Replace the system board.

1.

Reseat the graphics card (if applicable).

2.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

3.

Verify monitor is attached and turned
on.

4.

Replace the graphics card (if possible).

303-Keyboard Controller Error

304-Keyboard or System Unit Error

501-Display Adapter Failure

I/O board keyboard controller.

Keyboard failure.

Graphics display controller.

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1.

Reseat CPU fan.

2.

Reseat fan cable.

3.

Replace CPU fan.

1.

Reseat chassis, rear chassis, or front
chassis fan.

2.

Reseat fan cable.

3.

Replace chassis, rear chassis, or front
chassis fan.

1.

Reseat front chassis fan.

2.

Reseat fan cable.

3.

Replace front chassis fan.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

513-Front Chassis fan not detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

Front chassis fan is not connected or may
have malfunctioned.
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Control panel message

Description

Recommended action

514-CPU or Chassis Fan not Detected

CPU or chassis fan is not connected or may
have malfunctioned.

1.

Reseat CPU or chassis fan.

2.

Reseat fan cable.

3.

Replace CPU or chassis fan.

1.

Reseat power supply fan.

2.

Reseat fan cable.

3.

Replace power supply fan.

1.

Check and/or replace cables.

2.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

3.

Replace diskette drive.

4.

Replace the system board.

1.

Disconnect any other diskette controller
devices (tape drives).

2.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

515-Power Supply fan not detected

601-Diskette Controller Error

605-Diskette Drive Type Error

Power supply fan is not connected or may
have malfunctioned.

Diskette controller circuitry or floppy drive
circuitry incorrect.

Mismatch in drive type.

660-Display cache is detected unreliable

Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected

Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1151-Serial Port A Address Conflict Detected

Both external and internal serial ports are
assigned to COM1.

1.

Remove any serial port expansion
cards.

2.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

3.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.
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Control panel message

Description

Recommended action

1152-Serial Port B Address Conflict Detected

Both external and internal serial ports are
assigned to COM2.

1.

Remove any serial port expansion
cards.

2.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

3.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1.

Remove any serial port expansion
cards.

2.

Clear CMOS. (See Appendix B,
Password security and resetting CMOS
on page 249.)

3.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1.

Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System test
in F2 Diagnostics.

2.

Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3.

Back up contents and replace hard
drive.

1155-Serial Port Address Conflict Detected

1720-SMART Hard Drive Detects Imminent
Failure

Both external and internal serial ports are
assigned to same IRQ.

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options >
SATA Emulation to IDE, and select File >
Save Changes and Exit. Reenter
Computer Setup and select Security >
Drivelock Security. For each listed
Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change
Storage > Storage Options > SATA
Emulation back to RAID and select File >
Save Changes and Exit.

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1.

Upgrade BIOS to proper version.

2.

Change the processor.
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Control panel message

Description

Recommended action

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the computer,
restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

2201-MEBx Module did not checksum
correctly

2202-PMM Deallocation Error during MEBx
cleanup

2203-Setup error during MEBx execution
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Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

MEBx selection or exit resulted in a setup
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Control panel message

Description

Recommended action

2204-Inventory error during MEBx execution

BIOS information passed to the MEBx
resulted in a failure.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version.

3.

If the error still persists, replace the
system board.

2205-Interface error during MEBx execution

MEBx operation experienced a hardware
error during communication with ME.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMM1 is not installed.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file
properly.

1.

Try a different USB key device for
provisioning.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Update to the latest ME firmware
version.

2.

If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3.

If the error still persists, replace the
system board.

1.

Recreate the provisioning file using third
party management console software.

2.

If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3.

If the error still persists, replace the
system board.

2217-ME Firmware Version request failure

2218-ME Firmware Version should be
updated

2219-USB Key Provisioning file has invalid
header identifier

ME firmware is not properly responding to
BIOS query for version information.

ME firmware must be updated to match
current functionality contained in the system
BIOS.

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.

POST numeric codes and text messages
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Control panel message

Description

Recommended action

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key is
not a valid version for the current ME
firmware.

1.

Reboot the computer.

2.

If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3.

If the error still persists, replace the
system board.

Error occurred during MEBx execution which
fails into the “General” grouping. Status
information displayed along with the error
provides further clarity into the failure. MEBx
handles transference of information between
the system BIOS and ME firmware.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Error occurred during MEBx execution which
fails into “ME” grouping.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Electronic serial number is missing.

Enter the correct serial number in Computer
Setup.

2230-General error during MEBx execution

2231-ME error during MEBx execution

2232-AMT error during MEBx execution

2233-HECI error during MEBx execution

2239-ME image lock failure

2240-ME image unlock failure

Invalid Electronic Serial Number
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Error occurred during MEBx execution which
fails into “AMT” grouping.

Error occurred during MEBx execution which
fails into “MEI or HECI” grouping.
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Control panel message

Description

Recommended action

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1.

Reconnect keyboard with computer
turned off.

2.

Check connector for bent or missing
pins.

3.

Ensure that none of the keys are
depressed.

4.

Replace keyboard.

Parity Check 2

Parity RAM failure.

Run Computer Setup and Diagnostic utilities.

Interpreting POST diagnostic front panel LEDs and
audible codes
This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.
Recommended actions in the following table are listed in the order in which they should be performed.
Not all diagnostic lights and audible codes are available on all models.
Activity

Beeps

Possible cause

Recommended action

White Power LED On.

None

Computer on.

None

White Power LED flashes every
two seconds.

None

Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the mouse
to wake the computer.
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Activity

Beeps

Possible cause

Recommended action

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

2

Processor thermal
protection activated:

1.

Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2.

Open hood, press power button, and see if
the processor fan spins. If the processor fan
is not spinning, make sure the fan's cable is
plugged onto the system board header.

3.

If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4.

Contact an authorized reseller or service
provider.

Processor not installed (not
an indicator of bad
processor).

1.

Check to see that the processor is present.

2.

Reseat the processor.

Power failure (power
supply is overloaded).

1.

Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2.

Check if a device is causing the problem by
removing ALL attached devices (such as
hard, diskette, or optical drives, and
expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and repeat
this procedure until failure occurs. Replace
the device that is causing the failure.
Continue adding devices one at a time to
ensure all devices are functioning properly.

3.

Replace the power supply.

4.

Replace the system board.

A fan may be blocked or
not turning.
OR
The heat sink/fan
assembly is not properly
attached to the processor.

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

3

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

4

OR
The incorrect external
power supply adapter is
being used on the USDT.

OR
The USDT power supply adapter must be at
135W and use the Smart ID technology before
the system will power up. Replace the power
supply adapter with the HP-supplied USDT power
supply adapter.
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Activity

Beeps

Possible cause

Recommended action

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

5

Pre-video memory error.

CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

6

Pre-video graphics error.

1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate the
faulty module.

3.

Replace third-party memory with HP
memory.

4.

Replace the system board.

For systems with a graphics card:
1.

Reseat the graphics card.

2.

Replace the graphics card.

3.

Replace the system board.

For systems with integrated graphics, replace the
system board.
Red Power LED flashes seven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

7

System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

8

Invalid ROM based on
bad checksum.

1.

Reflash the system ROM with the latest BIOS
image.

2.

Replace the system board.

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

9

1.

Check that the voltage selector, located on
the rear of the power supply (some models),
is set to the appropriate voltage. Proper
voltage setting depends on your region.

2.

Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

3.

Replace the system board.

4.

Replace the processor.

System powers on but is
unable to boot.
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Activity

Beeps

Possible cause

Recommended action

Red Power LED flashes ten
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

10

Bad option card.

1.

Check each option card by removing the
card (one at a time if multiple cards), then
power on the system to see if fault goes
away.

2.

Once a bad card is identified, remove and
replace the bad option card.

3.

Replace the system board.

1.

Install a TXT capable processor.

2.

Disable TXT in the Computer Setup (F10)
utility.

3.

Reinstall the original processor.

Red Power LED flashes eleven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

11

System does not power on and
LEDs are not flashing.

None

The current processor does
not support a feature
previously enabled on this
system.

System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns white, the
power button is working correctly. Try the
following:
1.

Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2.

Replace the system board.

OR
Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
white then:
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1.

Check that the unit is plugged into a
working AC outlet.

2.

Open hood and check that the power button
harness is properly connected to the system
board.

3.

Check that both power supply cables are
properly connected to the system board.

4.

Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If the
problem persists, replace the system board.

5.

If the 5V_aux light on the system board is
not turned on, remove the expansion cards
one at a time until the 5V_aux light on the
system board turns on. It the problem
persists, replace the power supply.

11 Password security and resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.
This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password,
any user can access all the information on the computer except Computer Setup. When you establish
only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the setup password will
give you access to Computer Setup.
When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.
If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.
CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 180 for information on
backing up the CMOS settings.
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Resetting the password jumper
CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup
password or the power-on password, the computer is inaccessible and can no longer be used.
Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.
If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.
To prevent the computer from becoming permanently unusable, record your configured setup password
or power-on password in a safe place away from your computer. Without these passwords, the
computer cannot be unlocked.
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:
1.

Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2.

With the power cord disconnected, press the power button again to drain the system of any
residual power.
WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.
CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.
Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3.

Remove the access panel.

4.

Locate the header and jumper.
NOTE: The password jumper is green so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service Map
(IPSM). The IPSM can be downloaded from http://www.hp.com/support.
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5.

Remove the jumper from pins 1 and 2.

6.

Place the jumper on either pin 1 or 2, but not both, so that it does not get lost.

7.

Replace the access panel and reconnect the external equipment.

8.

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

9.

Shut down the computer, unplug the power, and disconnect the external equipment.
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10. Remove the access panel.
11. Place the jumper on pins 1 and 2.
12. Replace the access panel.
13. Reconnect the external equipment and plug in the computer.

Clearing and resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.
Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during
POST.
1.

Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2.

Disconnect the keyboard, monitor, and any other external equipment connected to the computer.
WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.
CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.
Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3.

Remove the computer cover or access panel.
CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important
to back up the computer CMOS settings before resetting them in case they are needed later. Back
up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 180 for
information on backing up the CMOS settings.

Clearing and resetting the CMOS
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4.

Locate, press, and hold the CMOS button in for five seconds.
NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM).
5.

Replace the computer cover or access panel.

6.

Reconnect the external devices.

7.

Plug in the computer and turn on power.
NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you
that configuration changes have occurred. Use Computer Setup to reset any special system setups
along with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 180.
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12 HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP
includes on all products. This tool can even be used if the computer will not boot to the operating
system.

Why run HP PC Hardware Diagnostics – UEFI
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite
the support process when issues are found. The tools save time by pinpointing the component that
needs to be replaced.
●

Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

●

Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.

How to access and run HP PC Hardware Diagnostics
- UEFI
To access the UEFI diagnostics:
1.

Restart or turn on the computer and press Esc repeatedly until the BIOS boot menu appears.

2.

Press F2 or select Diagnostics (F2).

Why run HP PC Hardware Diagnostics – UEFI
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After pressing F2, the BIOS sequentially searches three places for the system diagnostics:
a.

First – a connected USB drive (to download the diagnostics tools to a USB drive, see the
instructions in Downloading HP PC Hardware Diagnostics to a USB device on page 254).

b.

Second – the hard disk drive.

c.

Third – in the BIOS, a core set of diagnostics (for memory and hard disk drive) that are
accessible only if the USB or hard disk drive versions are not detected.

Downloading HP PC Hardware Diagnostics to a USB
device
1.

Go to http://www.hp.com.

2.

Click the Support & Drivers link.

3.

Select the Drivers & Software tab.

4.

Enter the product name in the text box and click Search.

5.

Select your specific computer model.

6.

Select your operating system.

7.

In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.
- or Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

NOTE: HP diagnostic solutions are developed to test components typically included on HP products.
They may not diagnose all third-party accessories that can be added to the system.
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13 System backup and recovery

Backing up, restoring, and recovering in Windows 8
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the tools provided, see Help and Support. From the Start screen, type h, and then select
Help and Support.

Backing up, restoring, and recovering in Windows 8
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Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the computer, create recovery media. This step creates a backup of
the recovery partition on the computer. The backup can be used to reinstall the original operating
system in cases where the hard drive is corrupted or has been replaced.
You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot
a Windows 8 computer that is unable to start. The USB flash drive can be used to reinstall the
original operating system and the programs that were installed at the factory.
NOTE: Any information on the USB flash drive will be erased before the recovery media is
created.
To create the recovery media, from the Start screen, type recovery drive, and then click on
Settings, then click on Create a recovery drive. Follow the on-screen instructions to continue.

2.

As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Windows Help and Support. From the Start screen,
type h, and then select Help and Support.

3.

As you add photos, video, music, and other personal files, create a backup of your personal
information. Windows File History can be set to regularly and automatically back up files from
libraries, desktop, contacts, and favorites. If files are accidentally deleted from the hard drive and
they can no longer be restored from the Recycle Bin, or if files become corrupted, you can restore
the files that you backed up using File History. Restoring files is also useful if you ever choose to
reset the computer by reinstalling Windows.
NOTE: File History is not enabled by default, so you must turn it on.
For more information and steps for enabling Windows File History, see Windows Help and
Support. From the Start screen, type h, and then select Help and Support.
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Restoring and recovering using Windows 8 tools
Windows recovery tools provide access to several options for recovering your system. Choose the
method that best matches your situation and level of expertise:
●

If you need to restore your personal files and data, you can use Windows File History to restore
your information from the backups you created. For more information and steps for using File
History, see Windows Help and Support. From the Start screen, type h, and then select Help
and Support.

●

If you want to restore the system to a previous state without losing any personal information,
Windows System Restore is an option. System Restore allows you to restore without the
requirements of Windows Refresh or a reinstallation. Windows creates system restore points
automatically during a Windows update and other system maintenance events. Even if you did not
manually create a restore point, you can choose to restore to an automatically created restore
point. For more information and steps for using Windows System Restore, see Windows Help and
Support. From the Start screen, type h, and then select Help and Support.

●

If you want a quick and easy way to recover the system without losing your personal information,
settings, or apps that came preinstalled on your computer or were purchased from the Windows
Store, Windows Refresh is an option. This method does not require backing up data to another
drive. See Using Windows 8 Refresh on page 257.

●

If you want to reset your computer to its original state, Windows Reset provides an easy way to
remove all personal data, apps, and settings, and reinstall Windows. The Reset recovery tool
reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled. Any personal files must be restored from
backups you made. See Using Windows 8 Reset on page 258.

●

If the computer is unable to start, you can use the Windows recovery USB flash drive you created
to recover the system. See Recovery using the Windows 8 recovery USB flash drive on page 259.

●

If the computer is unable to start and you did not create a recovery USB flash drive or the one you
created does not work, see Recovery using Windows 8 operating system media (purchased
separately) on page 260.

Using Windows 8 Refresh
NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select Help and
Support.
IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.
NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.

Backing up, restoring, and recovering in Windows 8
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If Windows is responding, use these steps to start Refresh:
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2.

Click Settings.

3.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4.

Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

If Windows is not responding, use these steps to start Refresh:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer
NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must
recover using the recovery media you created; see Recovery using the Windows 8 recovery USB
flash drive on page 259. Or you must use the Windows 8 operating system media and the Driver
Recovery media (purchased separately); see Recovery using Windows 8 operating system media
(purchased separately) on page 260

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the company
logo is displayed. The computer Startup Menu displays.

4.

Press f11 to select the System Recovery option.

5.

Choose your keyboard layout.

6.

Select Troubleshoot.

7.

Select Refresh.

8.

Follow the on-screen instructions to continue.

Using Windows 8 Reset
NOTE: You may be prompted for your permission or password when using Reset. See Windows
Help and Support for more information. From the Start screen, type h, and then select Help and
Support.
IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you wish to retain.
If Windows is responding, use these steps to start Reset:
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1.

On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2.

Click Settings.
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3.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4.

Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.

If Windows is not responding, use these steps to start Reset:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer.
NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must
recover using the recovery media you created; see Recovery using the Windows 8 recovery USB
flash drive on page 259. Or you must use the Windows 8 operating system media and the Driver
Recovery media (purchased separately); see Recovery using Windows 8 operating system media
(purchased separately) on page 260.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the company
logo is displayed. The computer Startup Menu displays.

4.

Press f11 to select the System Recovery option.

5.

Choose your keyboard layout.

6.

Select Troubleshoot.

7.

Select Reset.

8.

Follow the on-screen instructions to continue.

Recovery using the Windows 8 recovery USB flash drive
To recover your system using the recovery USB flash drive you previously created:
NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see
Recovery using Windows 8 operating system media (purchased separately) on page 260.
1.

If possible, back up all personal files.

2.

Insert the recovery USB flash drive you created into a USB port on your computer.

3.

Restart the computer and as soon as you see the HP logo screen, press f9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press
Enter to boot from that device.

4.

Choose your keyboard layout.

5.

Select Troubleshoot.

6.

Select Refresh your PC.

7.

Follow the on-screen instructions.
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Recovery using Windows 8 operating system media (purchased separately)
This recovery process requires Windows 8 operating system media, which can be ordered from the
support website. For U.S. support, go to http://www.hp.com/support. For worldwide support, go to
http://welcome.hp.com/country/us/en/wwcontact_us.html. You can also order the media by calling
support. For contact information, see the Worldwide Telephone Numbers booklet included with the
computer.
CAUTION: Using Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using Windows 8 operating system media:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then follow the instructions provided with the Windows 8 operating
system media to install the operating system.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the repair is completed and the Windows 8 desktop appears:
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1.

Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Backing up, restoring, and recovering in Windows 7
Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.
This section provides information about the following processes:
●

Creating recovery media and backups

●

Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the Windows Backup and Restore tools provided, see Help and Support. To access Help
and Support, select Start > Help and Support.
Recovery after a system failure is only as good as your most recent backup.
1.

After you successfully set up the computer, create recovery media. This media can be used to
reinstall the original operating system in cases where the hard drive is corrupted or has been
replaced. See Creating recovery media on page 261.

2.

As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Help and Support. To access Help and Support, select
Start > Help and Support.

3.

As you add photos, video, music, and other personal files, create a backup of your personal
information. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can restore the files that you
backed up. In case of system failure, you can use the backup files to restore the contents of your
computer. See Backing up your information on page 264.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Creating recovery media
After you successfully set up the computer, create recovery media. The media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced.
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There are two types of recovery media. To determine which steps to follow for your computer:
1.

Click the Start button.

2.

Click All Programs.
●

If Security and Protection is listed, continue with the steps in Creating recovery media
using HP Recovery Manager (select models only) on page 262.

●

If Productivity and Tools is listed, continue with the steps in Creating recovery discs with
HP Recovery Disc Creator (select models only) on page 263.

Creating recovery media using HP Recovery Manager (select models only)
●

To create recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs
(purchased separately). The discs you use will depend on the type of optical drive you are using.
NOTE: DVD+R DL, DVD-R DL, or DVD±RW disc are not supported.

●

You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.

●

If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

●

The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).
NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
To create recovery discs:
1.

Close all open programs.

2.

Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click HP Recovery Media Creation. If prompted, click Yes to allow the
program to continue.

3.

Click Create recovery media using blank DVD(s), and then click Next.

4.

Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:
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NOTE: You must use a USB flash drive with a capacity of at least 8 GB.
1.

Close all open programs.

2.

Insert the USB flash drive into a USB port on the computer.

3.

Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click Recovery Media Creation.

4.

Click Create recovery media with a USB flash drive, and then click Next.

5.

Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.
NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.

6.

Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

Creating recovery discs with HP Recovery Disc Creator (select models only)
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs
on select models. After you successfully set up the computer, you can create recovery discs using HP
Recovery Disc Creator. The recovery discs allows you to reinstall your original operating system as well
as select drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator
creates two kinds of recovery discs:
●

Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

●

Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

To create recovery discs, your computer must have a DVD writer. Use any of the following types of
discs (purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use
will depend on the type of optical drive you are using.
Creating recovery discs
NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to
create that media will not be available after you create a Windows DVD.
To create the Windows DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Windows disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.
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After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Driver disk.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.

Backing up your information
You should create your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. Your initial and subsequent backups allow you to restore your data and settings if a
failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated directories.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password. Refer to Help and Support. To access Help
and Support, select Start > Help and Support.
To create a backup using Windows Backup and Restore:
NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup.

System Restore
If you have a problem that might be due to software that you installed on your computer, or if you want
to restore the system to a previous state without losing any personal information, use System Restore to
return the computer to a previous restore point.
NOTE: Always use this System Restore procedure before you use the System Recovery feature.
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To start System Restore:
1.

Close all open programs.

2.

Click the Start button, right-click Computer, and then click Properties.

3.

Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

System Recovery
WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.
System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase. Any personal files must be restored from backups you made.
If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc
set from support. For U.S. support, go to http://www.hp.com/support. For worldwide support, go to
http://welcome.hp.com/country/us/en/wwcontact_us.html. You can also order the recovery disc set
by calling support. For contact information, see the Worldwide Telephone Numbers booklet included
with the computer.
NOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 264.
You must choose one of the following methods to perform a System Recovery:
●

Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 265 or System Recovery when Windows is not responding on page 266.

●

Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. See System Recovery using recovery
media (select models only) on page 266.

System Recovery when Windows is responding
CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.
NOTE: In some cases, you must use recovery media for this procedure. If you have not already
created this media, follow the instructions in Creating recovery media on page 261.
If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery:
1.

Turn off the computer.

2.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.
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3.

Turn on the computer.

4.

When Windows has loaded, click the Start button, click All Programs.
is listed, follow the steps in System Recovery when Windows is not responding on page 266.
●

If Security and Protection is listed, continue with step 5.

●

If Productivity and Tools is listed, follow the steps in System Recovery when Windows is
not responding on page 266.

5.

Click Security and Protection, click Recovery Manager, and then click Recovery
Manager. If prompted, click Yes to allow the program to continue.

6.

Under I need help immediately, click System Recovery.

7.

Select Yes, and then click Next. Your computer restarts.

8.

When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, click System Recovery. If you are prompted to back up your files,
and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

9.

System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

10. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding
CAUTION: System Recovery deletes all data and programs you created or installed.
If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.
1.

Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2.

Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3.

Press the power button to turn on the computer.

4.

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5.

At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6.

When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery using recovery media (select models only)
Use the steps provided in this section if you created recovery media using Creating recovery media
using HP Recovery Manager (select models only) on page 262. If you used HP Recovery Disc Creator
to create a Windows 7 operating system DVD and a Driver Recovery DVD, use the steps in Using HP
Recovery Disc operating system discs (select models only) on page 267.
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CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.
To perform a System Recovery using recovery media:
1.

If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2.

Click the Start button, and then click Shut Down.
or
If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.

3.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4.

Press the power button to turn on the computer, and press Esc as the computer is powering on to
display the startup menu.

5.

Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the
location where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.

6.

If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under I need help immediately, click Factory Reset.

7.

If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

8.

If you are prompted to insert the next recovery disc, do so.

9.

When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.

Using HP Recovery Disc operating system discs (select models only)
Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7
operating system DVD and a Driver Recovery DVD. If you created recovery media using Creating
recovery media using HP Recovery Manager (select models only) on page 262. use the steps in System
Recovery using recovery media (select models only) on page 266.
If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and
repair the operating system.
To order a Windows 7 operating system DVD and Driver Recovery DVD, go to the HP website. For
U.S. support, go to http://www.hp.com/support. For worldwide support, go to
http://welcome.hp.com/country/us/en/wwcontact_us.html. You can also order the DVDs by calling
support. For contact information, see the Worldwide Telephone Numbers booklet included with the
computer.
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CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.
NOTE: If the computer does not boot to the DVD, restart the computer and press Esc as the
computer is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press Enter. Use the arrow keys to select the location where the recovery DVD is inserted. Press
Enter to boot from that device.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Install now.

7.

Follow the on-screen instructions.

After the repair is completed:
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1.

Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2.

Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install
Recommended Applications.
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Battery replacement

The battery that comes with the computer provides power to the real-time clock. When replacing the
battery, use a battery equivalent to the battery originally installed in the computer. The computer comes
with a 3-volt lithium coin cell battery.
WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:
Do not attempt to recharge the battery.
Do not expose to temperatures higher than 60°C (140ºF).
Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.
Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.
NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5.

Remove the access panel.
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6.

Locate the battery and battery holder on the system board.
NOTE: On some computer models, it may be necessary to remove an internal component to
gain access to the battery.

7.

Depending on the type of battery holder on the system board, complete the following instructions
to replace the battery.
Type 1
a.

Lift the battery out of its holder.

b.

Slide the replacement battery into position, positive side up. The battery holder automatically
secures the battery in the proper position.

Type 2
a.

To release the battery from its holder, squeeze the metal clamp that extends above one edge
of the battery. When the battery pops up, lift it out (1).

b.

To insert the new battery, slide one edge of the replacement battery under the holder’s lip
with the positive side up. Push the other edge down until the clamp snaps over the other edge
of the battery (2).

Type 3
a.
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Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).
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b.

Insert the new battery and position the clip back into place.

NOTE: After the battery has been replaced, use the following steps to complete this procedure.
8.

Replace the access panel.

9.

Plug in the computer and turn on power to the computer.

10. Reset the date and time, your passwords, and any special system setups using Computer Setup.
11. Lock any security devices that were disengaged when the access panel was removed.
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Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC.
Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.
The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.
Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General requirements
The requirements listed below are applicable to all countries:
1.

The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2.

The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3.

The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.
WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese power cord requirements
For use in Japan, use only the power cord received with this product.
CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.
Country

Accrediting Agency

Country

Accrediting Agency

Australia (1)

EANSW

Italy (1)

IMQ

Austria (1)

OVE

Japan (3)

METI

Belgium (1)

CEBC

Norway (1)

NEMKO

Canada (2)

CSA

Sweden (1)

SEMKO

Denmark (1)

DEMKO

Switzerland (1)

SEV

Finland (1)

SETI

United Kingdom (1)

BSI

France (1)

UTE

United States (2)

UL

Germany (1)

VDE

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2.

The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3.

Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.

Country-specific requirements
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C

Specifications

TWR specifications
Chassis
Height

15.7 in

39.9 cm

Width

6.7 in

17.0 cm

Depth

17.4 in

44.2 cm

Approximate Weight

20.5 lb

9.3 kg

Operating

50° to 95°F

10° to 35°C

Nonoperating

-22° to 140°F

-30° to 60°C

Temperature Range

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no
direct sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and
number of options installed.
Relative Humidity (noncondensing)
Operating

10-90%

10-90%

Nonoperating (38.7°C max wet bulb)

5-95%

5-95%

Operating

10,000 ft

3048 m

Nonoperating

30,000 ft

9144 m

Maximum Altitude (unpressurized)

Power Supply
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Operating Voltage Range

90-264 VAC

Rated Voltage Range1

100-240 VAC

Rated Line Frequency

50-60 Hz

Operating Line Frequency

47-63 Hz

Standard Efficiency

320W
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Rated Input Current
1

5.5A

This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of
not requiring an input voltage range select switch.

SFF specifications
Chassis (in the desktop position)
Height

3.95 in

10.0 cm

Width

13.3 in

33.8 cm

Depth

14.9 in

37.9 cm

Approximate Weight

16.7 lb

7.6 kg

Weight Supported (maximum distributed load in desktop position)

77 lb

35 kg

Operating

50° to 95°F

10° to 35°C

Nonoperating

-22° to 140°F

-30° to 60°C

Temperature Range

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options
installed.
Relative Humidity (noncondensing)
Operating

10-90%

10-90%

Nonoperating (38.7°C max wet bulb)

5-95%

5-95%

Operating

10,000 ft

3048 m

Nonoperating

30,000 ft

9144 m

Maximum Altitude (unpressurized)

Power Supply

1

Operating Voltage Range

90-264 VAC

Rated Voltage Range1

100-240 VAC

Rated Line Frequency

50-60 Hz

Operating Line Frequency

47-63 Hz

Standard Efficiency

240W active PFC

Rated Input Current

4A

This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of
not requiring an input voltage range select switch.
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USDT specifications
Chassis
Height

2.60 in

6.6 cm

Width

9.90 in

25.1 cm

Depth

10.00 in

25.4 cm

Approximate Weight

6.8 lb

3.1 kg

Weight Supported (maximum distributed load in desktop position)

77 lb

35 kg

50° to 95° F

10° to 35° C

-22° to 140° F

-30° to 60° C

(depth will increase if the computer is equipped with a port security bracket)

Temperature Range (values subject to change with increasing altitude above
sea level)
Operating
Nonoperating

NOTE: Operating temperature is derated 1.0° C per 300 m (1,000 ft) to 3,000 m (10,000 ft) above sea level, no direct
sustained sunlight. Maximum rate of change is 10° C (50° F)/Hr. The upper limit may be limited by the type and number of
options installed.
Relative Humidity (noncondensing)
Operating (28° C (82.4° F) max wet bulb)

10-90%

10-90%

Nonoperating (38.7° C (101.66° F) max wet bulb)

5-95%

5-95%

Operating

10,000 ft

3,048 m

Nonoperating

30,000 ft

9,144 m

Maximum Altitude (unpressurized)

Power Supply

1
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Operating Voltage Range

90-264 VAC

Rated Voltage Range1

100-240 VAC

Rated Line Frequency

50-60 Hz

Operating Line Frequency

47-63 Hz

Rated Input Current

N/A

This system utilizes an active power factor corrected external power supply. This allows the system to pass the CE mark
requirements for use in the countries of the European Union. The active power factor corrected power supply also has the
added benefit of not requiring an input voltage range select switch.
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spare part number 48
USDT, spare part number 34
bezel blank (USDT), spare part
number 31
booting options
Full Boot 236
Quick Boot 236
C
cable lock, spare part number
17, 20, 24, 27, 31, 34
cable management 43
cable pinouts, SATA data 43
card reader
USDT removal and
replacement 166
USDT spare part number 166
cautions
AC power 35
cables 41
cooling fan 40
electrostatic discharge 35
keyboard cleaning 40
keyboard keys 40
CD-ROM or DVD problems 229
chasis types, illustrated 35
chassis fan
TWR, spare part number 20
USDT, spare part number 34

chassis stand
spare part number 24
cleaning
computer 39
mouse 40
safety precautions 39
CMOS
backing up 249
clearing and resetting 251
computer
specifications 275, 276
computer cleaning 39
country power cord set
requirements 273
Customer Support 195
D
deleted files
restoring for Windows 8
computer models 257
DIMMs. See memory
disassembly preparation
SFF 94
TWR 44
USDT 141
DisplayPort cable, spare part
number 16, 19, 23, 26, 30
DMS-59 to dual VGA cable, spare
part number 16, 19, 23, 26
drive power cable
SFF, spare part number 23,
28
TWR, spare part number 16,
21
drive rail
USDT removal and
replacement 164
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Driver Recovery DVD,
creating 263
using for restore 267
Driver Recovery media, Windows
8 260
drives
SFF locations 110
TWR cable connections 59
TWR installation 59
TWR locations 61
E
electrostatic discharge (ESD)
preventing damage 36
error
codes 236, 245
messages 237
expansion card
SFF installation 103
SFF removal 103
TWR installation 53
TWR removal 53

35

F
f11 recovery, Windows 8 257
fan
TWR spare part number 21,
87
TWR, spare part number 17,
20
USDT, spare part number 31,
34
fan duct
SFF removal and replacement
124
SFF spare part number 124
SFF, spare part number 24,
28
fan sink
SFF removal and replacement
135
SFF spare part number 135
SFF, spare part number 24,
28
TWR removal and
replacement 79
TWR spare part number 79
TWR, spare part number 17,
19, 21
fan, power supply 40
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flash drive problems 231
flashing LEDs 245
front bezel
removing blanks 99, 145
SFF removal and replacement
96
SFF security 97
SFF spare part number 96
SFF, spare part number 22,
28
TWR blank removal 48
TWR removal 47
TWR security 46
TWR spare part number 47
TWR, spare part number 15,
21
USDT removal and
replacement 143
USDT security 144
USDT spare part number 143
USDT, spare part number 29,
34
front fan
USDT removal and
replacement 150
USDT spare part number 150
front I/O assembly
SFF removal and replacement
130
SFF spare part number 130
SFF, spare part number 23,
28
TWR spare part number 76
TWR, spare part number 16,
21
USDT, spare part number 31
front panel components
SFF 4
TWR 3
USDT 5
front panel problems 232
front USB panel
TWR removal and
replacement 76
G
general problems 198
graphics board
USDT removal and
replacement 169

graphics card, spare part
number 19, 26
grounding methods 37
H
hard drive
proper handling 41
SATA characteristics 42
spare part numbers 18, 25,
32
USDT installation 154
USDT removal 154
hard drive (2.5-inch)
SFF installation 119
SFF removal 119
TWR installation 71
TWR removal 70
hard drive (3.5-inch)
SFF installation 116
SFF removal 116
TWR installation 71
TWR removal 70
hard drive problems 204
hard drive recovery
Windows 7 265
Windows 8 257
hardware installation problems
220
heat sink
USDT removal and
replacement 157
USDT spare part number 157
USDT, spare part number 31
Help and Support
Windows 7 261
helpful hints 196
hood sensor
SFF spare part number 128
spare part number 17, 19,
24, 26, 33
TWR spare part number 86
USDT removal and
replacement 165
USDT spare part number 165
HP Recovery Disc Creator, using
263
I
installing
battery 269

SFF 2.5-inch hard drive 119
SFF 3.5-inch hard drive 116
SFF expansion card 103
SFF media card reader 112
SFF memory 100
SFF slim optical drive 115
TWR 2.5-inch hard drive 71
TWR 3.5-inch hard drive 71
TWR 5.25-inch optical drive
62
TWR drive cables 59
TWR expansion card 53
TWR media card reader 66
TWR memory 50
TWR slim optical drive 68
USDT hard drive 154
USDT memory 147
USDT optical drive 153
Internet access problems 232
K
keyboard
cleaning 39
spare part numbers 18, 25,
32
keyboard problems 218
L
LEDs
blinking PS/2 keyboard 245
locks
SFF front bezel 97
TWR front bezel 46
USDT front bezel 144
M
media card reader
problems 207
SFF installation 112
SFF removal 111
TWR installation 66
TWR removal 64
memory
problems 226
SFF installation 100
SFF socket population 100
SFF specifications 100
TWR installation 50
TWR socket population 50
TWR specifications 50
USDT installation 147

USDT socket population 148
USDT specifications 147
memory modules
spare part number 15, 20,
22, 27, 50, 100
USDT, spare part number 29,
34, 147
monitor problems 209
mouse
cleaning 40
problems 218
mouse, spare part number 17,
24, 32
N
network problems 222
NIC, spare part number 21, 28
numeric error codes 237
O
operating guidelines 38
operating system media, Windows
8 260
optical disc drive mounting cage
USDT spare part number 31,
34, 164
optical drive
problems 229
spare part numbers 18, 20,
25, 26, 27, 32, 33
USDT installation 153
USDT release latch attachment
152
USDT removal 151
USDT, spare part number 151
optical drive (5.25-inch)
TWR installation 62
TWR removal 62
optical drive (slim)
SFF installation 115
SFF removal 114
TWR installation 68
TWR removal 67
optical drive cable/connector,
USDT
spare part number 30
overheating, prevention 38
P
password
clearing 249

power-on 249
setup 249
PCI expansion slot daughter card
TWR removal and
replacement 92
port cover
USDT spare part number 179
POST error messages 236
power cord set requirements
country specific 273
power problems 202
power supply
fan 40
operating voltage range 274,
275, 276
SFF removal and replacement
121
SFF, spare part number 22,
27
TWR removal and
replacement 89
TWR spare part number 89
TWR, spare part number 15,
20
power switch assembly
SFF removal and replacement
132
SFF spare part number 132
SFF, spare part number 23,
28
TWR removal and
replacement 77
TWR spare part number 77
TWR, spare part number 16,
21
USDT removal and
replacement 170
power-on password 249
printer port (expansion), PCI card
spare part number 24
printer port (expansion), spare part
number 17, 19, 26
printer problems 216
problems
audio 214
CD-ROM or DVD 229
flash drive 231
front panel 232
general 198
hard drive 204
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hardware installation 220
Internet access 232
keyboard 218
Media Card Reader 207
memory 226
monitor 209
mouse 218
network 222
power 202
printer 216
processor 228
software 234
processor
SFF removal and replacement
136
spare part number 15, 21,
23, 28, 30
TWR removal and
replacement 81
USDT removal and
replacement 159
processor problems 228
product ID locations 8
R
rear fan
TWR removal and
replacement 87
TWR, spare part number 21
USDT removal and
replacement 173, 174
USDT spare part number 173
rear panel components
SFF 7
TWR 6
USDT 8
rear port cover, USDT
spare part number 31
recovery discs, steps for creating
Windows 7 262
recovery discs, using for restore
267
recovery media, creating 263
recovery media, creating Windows
7 261
recovery partition, Windows 8
257
recovery USB flash drive, steps for
creating Windows 7 262

280

Index

recovery using Windows 8
operating system media 260
removal and replacement
power switch assembly 132
SFF fan duct 124
SFF fan sink 135
SFF front bezel 95, 96
SFF front I/O assembly 130
SFF hood sensor 128
SFF power supply 121
SFF processor 136
SFF Smart Cover Lock 125
SFF solenoid lock 125
SFF speaker 134
SFF system board 138
TWR fan 87
TWR fan sink 79
TWR front USB panel 76
TWR hood sensor 86
TWR PCI expansion slot
daughter card 92
TWR power supply 89
TWR power switch assembly
77
TWR processor 81
TWR solenoid lock 83
TWR speaker 82
TWR system board 92
USDT access panel 142
USDT card reader 166
USDT front bezel 143
USDT front fan 150
USDT graphics board 169
USDT heat sink 157
USDT hood sensor 165
USDT optical drive rail 164
USDT power switch 170
USDT processor 159
USDT rear fan 173, 174
USDT Smart Cover Lock 160
USDT solenoid lock 160
USDT speaker 156
USDT system board 171
USDT WLAN tuner module
168
removing
battery 269
bezel blanks 99, 145
SFF 2.5-inch hard drive 119
SFF 3.5-inch hard drive 116

SFF expansion card 103
SFF media card reader 111
SFF slim optical drive 114
TWR 2.5-inch hard drive 70
TWR 3.5-inch hard drive 70
TWR 5.25-inch optical drive
62
TWR access panel 45
TWR bezel blanks 48
TWR expansion card 53
TWR front bezel 47
TWR media card reader 64
TWR slim optical drive 67
USDT hard drive 154
USDT optical drive 151
resetting
CMOS 249
password jumper 249
restore
Windows File History 257
restoring the hard drive, Windows
8 257
rubber foot
spare part number 24
S
safety and comfort 195
safety precautions
cleaning 39
SATA
connectors on system board
42
data cable pinouts 43
hard drive characteristics 42
SATA cable
SFF, spare part number 23
SATA hard drive cable
TWR, spare part number 20
SATA optical drive cable
TWR, spare part number 20
screws, correct size 41
security
SFF front bezel 97
TWR front bezel 46
USDT front bezel 144
serial number locations 8
serial port (expansion), spare part
number 19, 26
serial port, spare part number 17,
24

service considerations 40
setup password 249
SFF
access panel, spare part
number 22, 28
disassembly preparation 94
drive power cable, spare part
number 23, 28
fan duct removal and
replacement 124
fan duct, spare part number
24, 28
fan sink removal and
replacement 135
fan sink, spare part number
24, 28
font I/O assembly, spare part
number 28
front bezel removal and
replacement 95, 96
front bezel, spare part
number 22, 28
front I/O assembly removal and
replacement 130
front I/O assembly, spare part
number 23
power supply removal and
replacement 121
power supply, spare part
number 22, 27
power switch assembly removal
and replacement 132
power switch assembly, spare
part number 23, 28
preparation for disassembly
94
processor removal and
replacement 136
SATA cable, spare part
number 23
Smart Cover Lock removal and
replacement 125
solenoid lock removal and
replacement 125, 128
solenoid lock, spare part
number 24
speaker removal and
replacement 134
speaker, spare part number
24, 28

system board removal and
replacement 138
system board, spare part
number 22, 27, 28
Smart Cover Lock
SFF removal and replacement
125
SFF spare part number 125
USDT spare part number 160
software
problems 234
servicing computer 41
solenoid lock
SFF removal and replacement
125, 128
SFF spare part number 125
SFF, spare part number 24
spare part number 28
TWR removal and
replacement 83, 86
TWR spare part number 83
TWR, spare part number 17,
19
USDT removal and
replacement 160
USDT spare part number 160
solid-state drive, spare part
number 18, 25, 32
spare part number
tamper-resistant wrench 41
Torx T-15 screwdriver 41
speaker
SFF removal and replacement
134
SFF spare part number 134
SFF, spare part number 24,
28
TWR removal and
replacement 82
TWR spare part number 82
TWR, spare part number 17,
20
USDT removal and
replacement 156
USDT spare part number 156
USDT, spare part number 31,
34
specifications
computer 274, 275, 276
SFF memory 100

TWR memory 50
USDT memory 147
stand (USDT), spare part number
29, 33
static electricity 36
system board
SATA connectors 42
SFF removal and replacement
138
SFF spare part number 138
SFF, spare part number 22,
27, 28
TWR removal and
replacement 92
TWR spare part number 92
TWR, spare part number 15,
20
USDT removal and
replacement 171
USDT, spare part number 29,
34
system board connections
SFF 107
TWR 57
USDT 146
System Recovery using Windows 7
recovery media
266
System Recovery, Windows 7
265
system restore point
creating for Windows 8
computer models 256
restoring for Windows 8
computer models 257
system restore points, creating
Windows 7 261
System Restore, Windows 7 264
T
tamper-proof screws
tool 41
temperature control 38
tools, servicing 41
Torx T15 screwdriver 41
tower conversion
SFF 140
USDT 178
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TWR
access panel, spare part
number 15, 21
disassembly preparation 44
drive power cable, spare part
number 16, 21
fan removal and replacement
87
fan sink removal and
replacement 79
fan sink, spare part number
17, 19, 21
fan, spare part number 17, 20
front bezel, spare part
number 15, 21
front I/O assembly, spare part
number 16, 21
front USB panel removal and
replacement 76
PCI expansion slot daughter
card 92
power supply removal and
replacement 89
power supply, spare part
number 15, 20
power switch assembly removal
and replacement 77
power switch assembly, spare
part number 16, 21
preparation for disassembly
44
processor removal and
replacement 81
SATA hard drive cable, spare
part number 20
SATA optical drive cable, spare
part number 20
solenoid lock removal and
replacement 83, 86
speaker removal and
replacement 82
speaker, spare part number
17, 20
system board removal and
replacement 92
system board, spare part
number 15, 20
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U
USB powered speakers, spare part
number 17, 19, 24, 26, 32, 33
USDT
AC adapter, spare part
number 29, 33
access panel removal and
replacement 142
access panel, spare part
number 29, 34
card reader removal and
replacement 166
chassis fan, spare part
number 34
disassembly preparation 141
drive rail removal and
replacement 164
fan (front), spare part number
31
fan (rear), spare part number
31
front bezel removal and
replacement 143
front bezel, spare part
number 29, 34
front fan removal and
replacement 150
front I/O panel, spare part
number 31
graphics board removal and
replacement 169
heat sink removal and
replacement 157
heat sink, spare part number
31
hood sensor removal and
replacement 165
optical disc drive mounting
cage, spare part number 31
optical drive cable/connector,
spare part number 30
power switch removal and
replacement 170
preparation for disassembly
141
processor removal and
replacement 159
rear fan removal and
replacement 173, 174

rear port cover, spare part
number 31
Smart Cover Lock removal and
replacement 160
solenoid lock removal and
replacement 160
speaker removal and
replacement 156
speaker, spare part number
31, 34
system board removal and
replacement 171
system board, spare part
number 29, 34
WLAN module removal and
replacement 168
V
ventilation, proper 38
W
Wake-on-LAN feature 222
Windows
backup 256
File History 256, 257
restoring files 257
system restore point 256, 257
Windows 7
backing up information 264
backup and recovery 261
Backup and Restore 264
creating backups 261
creating recovery media 261
creating system restore points
261
hard drive recovery 265
Help and Support 261
steps for creating recovery
discs 262
steps for creating recovery
media 262
steps for creating recovery USB
flash drive 262
System Recovery 265
System Recovery using recovery
media 266
System Restore 264
Windows 7 operating system discs
using for restore 267

Windows 7 operating system DVD
creating 263
using for restore 267
Windows 7 operating system
media
creating 263
Windows 8
backup and restore 255
Driver Recovery media 260
f11 recovery 257
hard drive recovery 257
operating system DVD 260
recovery partition 257
restoring the hard drive 257
WLAN module
USDT removal and
replacement 168
USDT spare part number 168
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